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Preface

This Implementation Guide describes how to take an installed version of Macro Space
Planning (MSP) and configure it so that a retailer can add additional information and
put it into production.

Audience

This document is intended for System Implementers (SIs) and MSP Administrators.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing
impaired.

Related Documents

For more information, see the following documents. in the Oracle Retail Macro Space
Management Release 14.1 and In-Store Space Collaboration documentation sets:

Macro Space Management
»  Oracle Retail Macro Space Planning Data Model

»  Oracle Retail Macro Space Planning Security Guide

»  Oracle Retail Macro Space Management Administration Module User Guide
»  Oracle Retail Macro Space Management Configuration Module User Guide
»  Oracle Retail Macro Space Management Data Importer User Guide

»  Oracle Retail Macro Space Management Fixture Studio User Guide

»  Oracle Retail Macro Space Management Merchandiser User Guide

s Oracle Retail Macro Space Management Planner User Guide

»  Oracle Retail Macro Space Management Report Designer User Guide

Xiii



»  Oracle Retail Macro Space Management Release Notes

In-Store Space Collaboration
»  Oracle Retail In-Store Space Collaboration User Guide

»  Oracle Retail In-Store Space Collaboration Mobile (ISSC Mobile) User Guide

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:
https:/ /support.oracle.com

When contacting Customer Support, please provide the following:

s Product version and program/module name

= Functional and technical description of the problem (include business impact)

s Detailed step-by-step instructions to re-create

= Exact error message received

= Screen shots of each step you take

Review Patch Documentation

When you install the application for the first time, you install either a base release (for
example, 14.1) or a later patch release (for example, 14.1.1). If you are installing the
base release or additional patches, read the documentation for all releases that have
occurred since the base release before you begin installation. Documentation for patch
releases can contain critical information related to the base release, as well as
information about code changes since the base release.

Improved Process for Oracle Retail Documentation Corrections

Xiv

To more quickly address critical corrections to Oracle Retail documentation content,
Oracle Retail documentation may be republished whenever a critical correction is
needed. For critical corrections, the republication of an Oracle Retail document may at
times not be attached to a numbered software release; instead, the Oracle Retail
document will simply be replaced on the Oracle Technology Network Web site, or, in
the case of Data Models, to the applicable My Oracle Support Documentation
container where they reside.

This process will prevent delays in making critical corrections available to customers.
For the customer, it means that before you begin installation, you must verify that you
have the most recent version of the Oracle Retail documentation set. Oracle Retail
documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle
part number, as well as print date (month and year). An updated version uses the
same part number, with a higher-numbered suffix. For example, part number
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all
previous versions.


http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

Oracle Retail Documentation on the Oracle Technology Network

Oracle Retail product documentation is available on the following web site:

http:/ /www.oracle.com/technetwork /documentation/oracle-retail-100266.html

(Data Model documents are not available through Oracle Technology Network. You
can obtain these documents through My Oracle Support.)

Conventions

The following text conventions are used in this document:

Convention

Meaning

boldface

italic

monospace

Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Send Us Your Comments

Oracle Retail Macro Space Planning Implementation Guide, Release 14.1

Oracle welcomes customers' comments and suggestions on the quality and usefulness
of this document.

Your feedback is important, and helps us to best meet your needs as a user of our
products. For example:

= Are the implementation steps correct and complete?

= Did you understand the context of the procedures?

= Did you find any errors in the information?

= Does the structure of the information help you with your tasks?

= Do you need different information or graphics? If so, where, and in what format?
= Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell
us your name, the name of the company who has licensed our products, the title and
part number of the documentation and the chapter, section, and page number (if
available).

Note: Before sending us your comments, you might like to check
that you have the latest version of the document and if any concerns
are already addressed. To do this, access the Online Documentation
available on the Oracle Technology Network web site. It contains the
most current Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number
(optional).

If you need assistance with Oracle software, then please contact your support
representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your
Oracle local office and inquire about our Oracle University offerings. A list of Oracle
offices is available on our web site at http: //www.oracle. com.
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Introduction

This chapter provides an overview of the implementation process. It is intended to
give System Implementers (Sls) an introduction to the requirements. The following
topics are covered:

= Overview of Implementation
s Information Sources

= Validation

= Starting Point

s Required Skills

s Concepts to Understand

s Points to Watch

Overview of Implementation

Scope

This implementation guide describes how to perform a basic implementation of Macro
Space Planning (MSP). MSP consists of two applications:

=  Macro Space Management (MSM). This is intended for use at headquarters.

= In-Store Space Collaboration (ISSC). This application (and its extension ISSC
Mobile) provides compliance capabilities at the store and enables stores and
corporate MSM users to collaborate.

This document provides the information to enable an SI, starting with an existing
installation of the software, to take MSP to a position where the retailer can add in the
detailed information required to take the software into production.

After the implementer has finished the actions specified in this guide, the retailer still
has to carry out further data entry before the application is in a position where it can
be put into production. Examples of this additional work are described in Chapter 13,
"Follow Up Actions."

Structure of this Implementation Guide

The implementation is carried out in a series of stages. This guide is structured to
follow this series of stages. Table 1-1 describes the stages.
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Overview of Implementation

Table 1-1 Implementation Sequence

Stage Description Notes

1 Security and Creating Access Creating additional users in order to configure the
system.

2 Base Data Configuration Setting up fundamental data to enable further setup.

3 Data Import Importing Store Hierarchy, Products, Planograms, and
so on.

4 Initial Fixture Studio Setup Carrying out basic configuration in Fixture Studio.

5 initial Planner Setup Creating basic floor plans in Planner.

6 Planner Configuration Configuring the Planner module.

7 Batch Processes Setting up batch processes for data import, publishing,
and so on.

8 ISSC Setup Configuring ISSC.

9 ISSC Mobile Configuring ISSC Mobile.

10 Configuring Reporting configuring the necessary Custom Queries, Quick

Reports, KPIs and external reports.

11 Follow Up Actions

Outline of how to integrate store planning into other
retailer systems.

12 Validation Tasks

Check list of actions to verify the configured
functionality is working as intended. This section is
intended as a preliminary to full User Acceptance
Testing.

Follow Up Work by Retailer

After the SI finishes the implementation process, further work is required by the
retailer before the application can be put into production. Table 1-2 lists examples of

the type of actions.

Table 1-2  Follow Up Work

Work

Description

Fixture and Gondola
Library

The SI has created and configured example fixtures and
gondolas. The retailer needs to create the full library of both.

Creating, Implementing,
and Validating Floor Plans

The SI has created or imported a number of example floor plans.
The retailer needs to create and validate the full range of
required floor plans.

Integrating MSP

MSP needs to be integrated into the retailer’s other systems, for
example, publishing a floor plan requires the pertinent orders to
be put into the retailer’s supply chain so the floor plan changes
can be made when the floor plan goes into service.

Additional Functionality
Out of Scope for this
Implementation Guide

This implementation guide describes how to configure the basic
functionality required to enable a retailer to begin store
planning. MSP contains additional, more complex functionality
that a retailer may require, but which is not a prerequisite for
implementation. For some examples, see Chapter 13, "Follow Up
Actions.".
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Information Sources

Validation

Appendix A, "Information Locations" provides lists of where more detailed
information on specific aspects of MSP functionality can be found. In addition, a
glossary provides a list of the more common MSP terms.

Chapter 14, "Validation Tasks" suggests steps to validate the installation. The steps
help confirm that the functionality that has been configured is broadly working as
intended. The suggested validation methods are not intended to test all aspects of the
functionally, nor should they be regarded as a substitute for a full User Acceptance
Test.

Starting Point

The starting point for the implementation is after the completion of the installation
process. This requires the following:

s The template database is installed and awaiting configuration. Scripts are
provided for both an imperial and a metric database.

= Database connection is established using the Database Configuration Tool
(MSMDBConfigTool.exe)

=  MSM is installed and the user is ready to log in using
ADMINISTRATOR /ORMSM2011.

s ISSCis installed and awaiting configuration.
= ISSC Mobile is installed and awaiting configuration.

= Additional software, such as Oracle Data Integrator (OD]), is installed and
awaiting configuration.

Required Skills

Table 1-3 and Table 14 list the skills required from the implementation team.

Table 1-3 Required MSP Skills

Skill Description

Environment Skills Macro Space Planning is installed in a series of different
environments. For example, the database may be installed in a
Linux environment, while MSM and ISSC must be installed in a
Windows environment.

AutoCAD Skills The implementation requires the creation of basic fixtures and
floor plans. This requires the ability to create blocks in AutoCAD
and to place and manipulate them in the Planner module. It also
requires basic AutoCAD skills, such as, drawing shapes to
represent aisles and zones.

Oracle 12c Database Users should understand how to administer and manage an
Oracle 12C database and its associated clients.

SQL Skills Some implementation tasks involve direct modification of date
in database tables. Other tasks involve writing SQL statements.
If there are problems during implementation, diagnosis may
involve looking at the content of database tables if granted
access by the DBA.

Introduction 1-3



Required Skills

Table 1-4 Knowledge of Other Software

Software Description

ODI ODI comes pre-configured for importing planogram definitions
from an XML file. Implementers should be capable of:

= Installing ODI and following the required steps to set up the
planogram import scenarios.

= Creating the XML file that is the required starting point for
planogram import using ODI and its provided
pre-configured scenarios.

SQL Developer This is an Oracle tool useful for working with the content of
databases.
BI Publisher BI Publisher is the standard Oracle reporting tool. If used, SIs

should be familiar with its installation and use.

Scheduling Tool MSP requires a number of batch processes to be run at regular
intervals. Implementers should be familiar with the scheduling
tool in use at the retailer.

Basic Functionality in MSP

Implementers should understand the basic functionality within MSP so they can carry
out the implementation tasks. Such functionality includes the lists in Table 1-5 and
Table 1-6.

Table 1-5 MSM Knowledge Required

MSM Functionality Description

Administration Module How to configure users and user groups, data security, and
system variables.

Data Importer How data imports are executed and logged. How to create the
CSV files that are the source for the import.

Fixture Studio How to configure fixtures and gondolas.

Merchandiser Module How to view the planogram hierarchy and associated
planogram information. This enables the planogram imports to
be validated.

Planner Module How to create a basic floor plan, including using the

functionality in the Object Browser and Object Grid.

Product Studio How to view the product hierarchy and the associated products.
This enables any products brought in during planogram import
to be verified.

Report Designer How to configure a basic planogram report.
Quick Reports and KPIs How to configure Quick Reports and Key Performance
Indicators.

Table 1-6 ISSC and ISSC Mobile Functionality

Functionality Description

ISsC How to place fixtures, product, and planograms. How to use
KPIs.

ISSC Mobile How to use notes and the predefined KPIs function.
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Concepts to Understand

Table 1-7 list the concepts that the implementer should understand prior to beginning
to configure the application.

Table 1-7 Concepts

Concept Description

Architecture of MSP How MSP is configured and sits on the varying platforms it is
installed on. The SI should also understand any performance
constraints imposed by the hardware chosen by the retailer.

Store Planning Process SIs should understand the general principles of the store
planning process. The process can vary from retailer to retailer,
but involves the use of statuses to show where a floor plan is in
its business life cycle, how to lay out zones, equipment, and
merchandise and how to use the reporting tools to both validate
the floor plan and report on results.

Integration of Store How the store planning process integrates into the other systems
Planning Process at the retailer, for example, the planogram design process and
supply chain.

Points to Watch

Cached Values

Custom SQL

This section describes a number of general points that affect implementation. Sls
should bear them in mind during the implementation process.

Some MSP modules cache values when they are opened. This means that, for example,
if changes are made to system variables in the Administration module, they may not
take effect in other modules if those other modules are open. In this event, close and
reopen the modules to get the changes to take effect.

Another example of caching values is the ISSC Server Service. In order for a number of
changes to take effect, this must be stopped and restarted. (Stopping and restarting
disconnects all current ISSC and ISSC Mobile users).

Macro Space Planning uses Custom SQL. This is an extension of standard SQL that
allows for the use for placeholders (denoted by the use of curly brackets). The
functionality substitutes the pertinent value of the placeholder when it executes the
SQL statement. Following is a simple example:

Select * from AVTTB_STORE where STR_ID = {STR_ID}

When the statement is executed, the code substitutes the actual STR_ID for the
currently active floor plan for the {STR_ID} placeholder. The statement that is
executed:

Select * from AVTTB_STORE where STR_ID = 123

This means implementers and administrators can write generic SQL statements that
will execute against the currently active object in the application. Whether standard or
custom SQL is in use in the application can be determined by looking at the default
SQL provided; only custom SQL statements have placeholders. If modifying SQL
statements, the correct type must be determined and used; either Standard SQL or
Custom SQL.
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Next ID

MSP keeps track on the next primary keys to be allocated using the AVITB_NEXTID
table. These are updated automatically when functionality is manually invoked, but
are not necessarily updated by batch processes. If batch processes are in use, or if the
SI has inserted data into the database using a SQL statement, the Next ID must be
updated to avoid referential integrity problems. This can be done by several methods.
One is manually by the Update ID Table option from the Tools menu of the
Administration module. Another is to call the AVISP_UPDATE_NEXT_IDS stored
procedure.
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Preparations

This chapter provides an overview of the preparatory work that must be done prior to
beginning the implementation. Much of this information must be obtained from the
retailer. The following topic is covered:

s Requirements Gathering

Requirements Gathering

Table 2-1 lists the information that the SI needs to determine from the retailer’s

requirements.

Table 2-1 Information on Retailer’s Systems

Information

Description

Stores and Store Hierarchy

The SI should be aware of the retailer’s store information and
the clusters in which they are organized, together with the
system this is imported from and the format the data is held in.

Zones and Zone Hierarchy

The SI should determine what departments (zones) the retailer
uses and how they are organized in a hierarchy.

Fixture and Fixture Library

The SI should determine the list of required fixtures and how
they are to be organized in a fixture hierarchy. The SI should also
determine a suitable subset of the retailer’s fixtures to use when
creating an example store plan for the configuration tasks.

Gondolas and Gondola
Hierarchy

The SI should determine what gondolas are required and how
they are to be organized in the gondola hierarchy. The SI also
should also determine a suitable example gondola to use when
creating an example store plan for the configuration tasks

Products and Product
Hierarchy

The SI should be aware of the retailer’s product information and
the hierarchy in which they are organized, together with the
system this is imported from and the format the data is held in.

Planograms and Planogram
Hierarchy

The SI should be aware of the retailer’s planogram information
and the hierarchy in which they are organized, together with the
system this is imported from and the format the data is held in.

Planogram Substitutions

The SI should be aware of the retailer’s method for specifying
planogram substitutions and how to import the information into
MSP. Although these substitutions can be manually configured
in MSP, importing them may be a more efficient method of
setting up large numbers.

MSP also allows for planogram version change where the design
of the planogram has been slightly modified, but where the scale
of the change is not sufficient to define the planogram as a new
design.
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Table 2-1 (Cont.) Information on Retailer’s Systems

Information

Description

Integration with Retailer’s
Systems

Some information may be exported from MSP. An example of
this is the merchandise required to reset planograms when a
floor plan goes into service. SIs should be aware of how this
information is to be exported and the integration points into the
retailer’s other systems.

The integration of MSP into the retailer’s other systems is
outside of the scope of this implementation guide and this
requirement is purely for illustrative purposes.

Table 2-2 lists information that the SI should determine about the configuration

required in MSP.

Table 2-2 Information on Required Configuration

Policy

Information

Password Security

The SI should determine the retailer’s policies on password
strength, number of permissible log in attempts, and so on.

User and User Groups

Access to the functionality in MSM and to stores in ISSC and
ISSC mobile is determined by which User Groups a user belongs
to. User Groups can also be used to control access to
merchandise in ISSC. SIs should determine which User Groups
are required to control access.

Data Importer Preparation

Data Importer can be used to import base data. The most likely
imports are stores and their hierarchy, the fixture hierarchy,
fixture information, and product hierarchy.

Data Importer comes configured with these and other
predefined imports. The data for those imports is required in
CSV format. These CSV files are not provided. If data is to be
imported using Data Importer, the format of the CSV files needs
to be determined and the data prepared accordingly.

Batch Processes

Many operations are run as batch processes. Examples include
running planogram substitutions and publishing floor plans and
planograms. SIs should determine the batch processes required,
sequence they need to be run in, time window available to run
batch processes, and estimated time required to run each batch
process.

Changes to Custom Queries

The Custom Queries govern how information appears in specific
dialog boxes, for example, the Find dialog boxes. These should
be reviewed and the retailer asked if they meet requirements.

Changes to Quick Reports

The Quick Reports are dialog boxes containing customizable
information on objects in a floor plan or planogram. The retailer
should be asked which ones should be deleted and which
retained. They should also be asked if any additional Quick
Reports are required.

Changes to KPIs

KPIs are ways of color coding floor plans and planograms to
show validation or performance information. The retailer should
be asked which ones should be deleted or retained. Any
additional KPIs required should be determined.

Reporting Tools, such as, BI
Publisher

The SI should know what reports are to be configured using a
reporting tool such as BI Publisher. An example is creating
reports to report on the content of the log tables in the database.
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Overview

Initial Log In

Security and Creating Access

This chapter covers the actions to set up the initial Macro Space Management (MSM)
users and their privileges. It then explains more advanced configuration, especially for
In-Store Space Collaboration (ISSC) and its extension ISSC Mobile. The following
topics are covered:

s Overview

= Initial Log In

s Initial Actions in the Administration Module
»  Creation of Additional User Groups

»  ISSC User Groups

»  Creation of Users and Associating with User Groups

When Macro Space Planning is first run, the database is populated with sufficient
information for the application to open. This section describes how to set up the
security options for initial users of MSM and more complex arrangements of users and
user groups, primarily for ISSC.

For details on where to find detailed information on the actions in this chapter, see
Appendix A, "Information Locations."

The supplied template database comes with the following default user name and
password:

s User Name: ADMINISTRATOR
s Password: ORMSM2011

The password is set to expire on the first login which requires that it be changed. Until
additional users are created, this login is the only way of accessing the application. If
this login is used during the installation process, the installation team should be asked
for any modified user names or passwords.

Initial Actions in the Administration Module

The following actions are all carried out in the Administration module.
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Initial Actions in the Administration Module

Set Security Options

Security options are used to set parameters such as password length and complexity,
number of login attempts allowed, the interval at which passwords expire and require
changing, and so on. These parameters are set in the Security Options dialog box
accessed from the Security menu in the Administration module.

Some of the required settings cause all existing passwords, other than the currently
logged in user, to expire. Accordingly, configuring the security options should be the
first task carried out during implementation. Settings chosen should conform to the
retailer’s security policies.

Add Other MSM Administration Users

If multiple people are to help with the implementation, other users should be added to
the Admin User Group in the User Groups tab of the Functional Security dialog box
accessed from the Security menu in the Administration module. Members of this user
group have access to all the functionality in MSM.

Associate MSM User Groups with Functionality

The application comes pre-configured with the user groups shown in Table 3-1.

Table 3—-1 Pre-configured User Groups

User Groups Description
Admin Already configured with access to all MSM modules.
Floor Layout Intended for planners laying out zones and equipment. Not yet

associated with any MSM modules, so access has to be
configured in the Group relationships tab of the Functional
Security dialog box in the Administration module.

In-Store Gives access to the ISSC toolbar. Not yet associated with any
stores, file statuses, or products, so access has to configured. For
information on how to configure access to these, see "ISSC User
Groups."

Merchandiser Intended for planners laying out products and planograms. Not
yet associated with any MSM modules, so access has to be
configured in the Group relationships tab of the Functional
Security dialog box in the Administration module.

The Floor Layout and Merchandiser User Groups are adequate for this level of
implementation in MSM, although the SI could add additional ones if required. The SI
must then associate those user groups with the pertinent functionality on the Group
Relationships tab of the Functional Security dialog box accessed from the Security
menu.

Floor Layout User Group

The Floor Layout User Group could be given access to Fixture Studio to allow fixtures
and gondolas to be configured, together with access to the Planner module to allow
the users to lay out zones, fixtures, and gondolas.

Table 3-2 Command Groups for the Floor Layout User Group

Command Group Description

Planner Access to the Planner module.
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Table 3-2 (Cont.) Command Groups for the Floor Layout User Group

Command Group Description

Planogram Studio Access to the Merchandiser module.

Merchandiser User Group

The Merchandiser User Group could have access to Planner to allow a floor plan to be
merchandised, access to the Merchandiser module to see planogram designs, and
access to Product Studio to see products and their hierarchy.

Table 3-3 Command Groups for the Merchandiser User Group

Command Group Description

Planner Access to the Planner module.
Planogram Studio Access to the Merchandiser module.
Product Studio Access to the Product Studio module.

It is also important to ensure that any user groups associated with the Planner
Command Group in the Group Relationships tab of the Functional Security dialog box
have a minimum of Read permission. This is to ensure that members of the user group
have access to the Find and Open, Search and Print, and Automated Processing dialog
boxes.

To set these permissions:
1. Open the Function Security dialog box and select the Group Relationships tab.
2. Highlight the pertinent User Group, right click, and select Edit Permissions.

3. In the Edit Permissions dialog box, ensure that a minimum of Read permissions
are checked and click OK.

Finally, The Merchandiser User Group will need access to the pertinent planogram
user groups in the Data Security dialog box. This allows them to select planograms for
planogram substitution and for immediate planogram publishing.

Add Other MSM Users

If some users are to carry out some of the implementation tasks in MSM without
getting access to the Administration module, the users should be created and added to
the Floor Layout and Merchandiser User Groups.

Creation of Additional User Groups

Additional User Groups may be required dependent on the business requirements.

MSM User Groups

It may be useful to create MSM user groups for specific purposes. Three examples are
given below. Many others are possible.

Batch Processes

One such user group (and user) would be used for running batch processes. Running
batch processes using the command line requires a valid MSM user name and
password. These processes then run unattended using this log in. The Batch Process
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User Group needs access to the Command Groups listed in Table 3—4.

Table 3-4 Command Groups for the Batch Process User Group

Command Group Description

Automation Membership in this group allows access to the Automated
Calculation, Floor Plan Automated Processing, Floor Plan
Publishing, Planogram Publishing, and Update Status

functionality.
Data Importer Gives access to the Data Importer module.
Planogram Substitution Gives access to the Planogram Substitution functionality.

It is not anticipated that anyone logging in using the Batch Process User Group needs
to manually run functionality. Accordingly, no access is required to modules such as

Administration and Planner.

The other batch processes are invoked using BatchRunner. For more information, see
Chapter 9, "Batch Processes.". This requires a valid MSM login and access to any
required Command Groups - for example the Floor Plan Publishing Command Group.

Once created, the Batch Process User Group needs a single user associated with it for
login purposes when batch processes are run.From a security perspective, a set of log
in credentials for MSP is exposed within any associated batch files. Therefore this user
should have the minimum privileges required to run batch processes. It should not

have wider credentials to - for example - the Administration module.

Merchandise Manager

Another potential user group is that for Merchandise Managers. These would have
privileges additional to merchandiser planners. An example of the functionality they

might be given access to is given in Table 3-5.

Table 3-5 Command Groups for the Merchandise Manager User Group

Command Group Description

Planogram Publishing Gives access to configuring and running planogram publishing

(Child of the Automation as a batch process.
Command Group)

Planner Access to the Planner module.

Planogram Studio Access to the Merchandiser module.

Planogram Substitution Access to the Planogram Substitution module - able to configure
substitutions.

Product Studio Access to the Product Studio module.

Report Designer Access to the Report Designer module - able to configure

planogram reports.

ISSC User Groups

ISSC and ISSC Mobile may require the creation of a large number of User Groups. The
basic concepts are covered in the following sections. In some cases, it may be
preferable to use a SQL script instead of manually creating User Groups manually in

the Administration module.
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Preparatory work

Before starting to implement in ISSC, some preliminary analysis is required.

Decide on User Group Strategy

One of the key decisions is the user group strategy for ISSC. User groups control
access to stores, file status, and products. Some of these ISSC user groups can also be
used in common with ISSC Mobile. ISSC Mobile requires one user group per store, so
these user groups could also be used for the lowest level of granularity in ISSC. For
maximum granularity of access, three types of user group roles are required for ISSC.
The user group roles are listed in Table 3-6.

Table 3—-6 ISSC User Group Roles

Purpose Description Type of Security
Access to This controls access to what functionality can be Functional
functionality used on the toolbar. It should also be used to grant

access to floor plan (file) statuses. For information
on setting up files statuses see Setting up Statuses
for the ISSC Workflow in the chapter on Setting up

ISSC.
Access to stores and  This controls access to stores. Data
file statuses
Access to product This controls access to the product hierarchy at the Data
hierarchy Department level.

Typically, a user is given access to a minimum of one of each type of user group. The
three user groups in combination determine the access a user has. Following is an
example for a store planner:

»  The store planner is a member of the In-Store user group that gives access to most
of the functionality on the toolbar. Access will have also have been granted for
specific file statuses - floor plans outside of these statuses cannot be seen in ISSC.

»  The store planner is a member of the North West user group, that gives them access
to the twelve stores they have planning responsibility for.-

»  The store planner is a member of the Food and Drink user group, that gives access
to the products in the Food and Drink department (zone) for product placement
purposes.

If less granularity of access is required, the number of user groups could be reduced.
For example, a user group could be created that allows access to both a specific set of
stores and the required file statuses.

For more detail on these user groups types, see "Functionality Type User Groups.".
Business Processes

It is possible to configure ISSC to cater to different business roles. Table 3-7 lists
examples.
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Table 3-7 Configurable Business Processes

Business Role Description

Changing Floor Plan Status  The Save dialog boxes are used for this process. They enable the

status of the floor plan to be changed to signify approval or
rejection at the current stage in its business life cycle.

A floor planner might have the Save dialog box with the Submit
button, allowing them to change the status to one requiring
managerial approval. A manager might have the Save dialog
box with the Accept and Reject buttons, allowing them to return
the floor plan to an earlier status for correction or set it to
approval to go into service.

District Manager Button This button allows bulk acceptance or rejection of floor plans

with the corresponding changes in status. This button has to be
enabled for specific user groups before it becomes available. All
floor plans at a specific status can then be made visible in the
ISSC Store selection dialog box. This allows the manager to
select each in turn and change the status without opening the
floor plan.

Functionality Type User Groups

The only user group in the predefined user groups to get access to the ISSC toolbar is
the In-Store User Group, supplied as a default. This user group gives access to all the
functionality except the District Manager button.

Creating a User Group with Access to the Toolbar

To create another user group with access to the ISSC toolbar, create the user group in
the User Groups tab of the Functional Security dialog box accessed from the Security
menu in the MSM Administration module:

This newly created user group will not have access to the toolbar.

Which toolbar buttons are visible to a user group are set up directly in the
database through the AVITB_MESSAGE_USER_GROUP_LINK table. The MUG_
PERMISSION mask must be set to 1 for a toolbar button to be visible. The list of
MSC_IDs used in the ISSC toolbar can be copied from one user group to another
with a simple SQL statement:

INSERT INTO AVTTB_MESSAGE_USER_GROUP_LINK
SELECT [User Group ID], MSC_ID, MUG_PERMISSION_MASK
FROM AVTTB_MESSAGE_USER_GROUP_LINK WHERE USG_ID = 4

The [User Group ID] should be the user group to which access to the ISSC
Toolbar is to be given. This is the USG_ID from the AVITB_USER_GROUP table.
USG_ID = 4 is the existing user group with access to the toolbar. The SQL
statement copies the permissions from that user group into the new one.

The User Group should also be given access to the ISSC Command Group in the
Group Relationships tab of the Functional Security dialog box. Without access to
this command group, users are not able to access functionality in ISSC.

Creating a User Group with Access to Toolbar and District Manager Button
Follow the steps in the previous section to create a user group with access to the
toolbar. By default, the District Manager button in the toolbar is turned off. To turn it
on, use the following simple SQL statement:

UPDATE AVTTB_MESSAGE_USER_GROUP_LINK
SET MUG_PERMISSION_MASK = 1 WHERE MSC_ID = 7243 AND USG_ID = [User Group ID]
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The [User Group ID] should be the user group to which access to the District
Manager button is to be given. This is the USG_ID from the AVITB_USER_GROUP
table.

Note: Additional configuration is required in the Status dialog box
accessed from the General menu in the Administration module. For
more information, see "Store and File Status User Group."

Making a User a Member of a User Group

To give users access to the Functionality User Groups, use the User Groups tab of the
of the Functional Security dialog box accessed from the Security menu in the MSM
Administration module.

Membership of a user group can also be configured directly in the database by using a
SQL script. This can be used to add entries to the AVITB_USER_GROUP_LINK table.
It is used to connect the list of users in the AVITB_USER table and list of user groups
in the AVTTB_USER_GROUP table.

Store and File Status User Group

This user group controls access to the stores and file statuses for all users who are
members of it. This type of user group can be configured with different levels of
granularity. At the lowest level of granularity (one store per user group), it can be used
to control access to both ISSC and ISSC Mobile. At the opposite end of the spectrum, it
would be possible to configure a single user group with access to all stores.
Intermediate between the two would be a user group giving access to all stores within
a cluster:

s Those that are members only of the Store and File Status user group are able to
access the store in ISSC Mobile, but not access the toolbar in ISSC.

= Members of this user group that also have access to the ISSC toolbar (for example
by being a member of the In-Store User Group) are also able to log in to ISSC.

ISSC users thus need access to both the functionality and the store.

Manually Creating and Configuring the User Group
To create and configure this type of user group:

1. Create an appropriately named User Group in the User Groups tab of the
Functional Security dialog box accessed from the Security menu in the MSM
Administration module. Close this dialog box.

2. Associate the User Group with the pertinent store in the Store tab of the Data
Security dialog box accessed from the Security menu in the MSM Administration
module. For ISSC Mobile, you must also have permission for the status that
particular store is at.

3. Associate the User Group with the pertinent file statuses in the Status tab of the
Data Security dialog box accessed from the Security menu in the MSM
Administration module. Permission for File statuses in not required for ISSC
Mobile users. They can only see files at Current status.

4, ISSC Mobile users must also have their User Group associated with the ISSC
Mobile command Group in the Group Relationships tab of the Functional Security
dialog box in the Administration module.
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The floor plans that will be visible need to have permissions for both the parent store
for the floor plan and the status the floor plan is currently at.

Note: If the permissions are not present, the floor plans will not be
visible

Scripting and Configuring the User Group

The data for creating user groups and assigning those user groups to stores is held in
the tables listed in Table 3-8.

Table 3-8 Tables for Assigning User Groups to Stores

Table Description

AVTTB_CLUMP Holds a list of clusters with CLU_ID as the primary
key. The CLU_ID can be used to assign the a specific
user group to all stores in that cluster.

The CLT_ID identifies the cluster type. This can be
used in conjunction with the CLU_ID to give more
flexibility in how user groups are assigned to stores.

AVTTB_STORE Holds a list of stores with STR_ID as the primary key.

AVTTB_STORE_CLUMP_LINK Links the AVITB_CLUMP and AVTTB_STORE tables.

AVTTB_USER_GROUP Holds a list of user groups with USG_ID as the
primary key.

AVTTB_USER_STORE_GROUP_LINK Lilr;lks the AVITB_STORE and AVITB_USER_GROUP
tables.

Creating the User Groups

The simplest way of creating the user groups at the lowest level of granularity is to use
a SQL insert statement to add a user group named after a store or store code. This
gives one user group per store the level of granularity required for store-specific user
groups. To create user groups at a higher level of granularity, it is possible to use an
insert statement to add a user group named after a cluster. This approach would
typically be used for user groups associated with district managers or other staff with
responsibilities for groups of stores.

An example of a SQL statement is:

INSERT INTO AVTTB_USER_GROUP (USG_ID, USG_PID, USG_NAME, USG_DESC, USG_MANDATORY,
ICO_ID, USG_LIC, USG_CODE, UGT_ID)

SELECT

(SELECT MAX(USG_ID) FROM AVTTB_USER_GROUP) + ROWNUM AS USG_ID,

(SELECT USG_ID FROM AVTTB_USER_GROUP WHERE UGT_ID=0 AND USG_PID IS NULL AND
ROWNUM=1) AS USG_PID,

'Store ' || STR_CODE AS USG_NAME,

'Store ' || STR_CODE AS USG_DESC,

0 AS USG_MANDATORY, 45 AS ICO_ID,NULL AS USG_LIC,
'ST' || STR_CODE AS USG_CODE, 0 AS UGT_ID

FROM AVTTB_STORE

This statement may need to be adapted to suit a retailer’s specific requirements.
Associating the User Group with the Store

To associate the user group with the store at the lowest level of granularity, use a
simple insert statement to populate the STR_ID and USG_UD fields in the AVTTB_
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STORE_USER_GROUP_LINK table. The UTL_PERMISSION_MASK can be set to a
value of fifteen - this will give all permission.

For a higher level of granularity, that associated with clusters, use a select statement to
selectallstoresassociated withaspecificclusterinthestorehierarchy
and insert them into the AVITB_STORE_USER_GROUP_LINK table.

Associating the User Group with the Status

The data for creating user groups and assigning those user groups to files is held in the
tables listed in Table 3-9.

Table 3-9 Tables for Assigning User Groups to Stores

Table Description

AVTTB_STATUS Holds a list of statuses with STA_ID as the primary
key. File statuses have a status type (STT_ID) of 7.

AVTTB_USER_GROUP Holds a list of user groups with USG_ID as the
primary key.

AVTTB_USER_GROUP_STATUS_LINK Links the AVTTB_STATUS and AVTTB_USER _
GROUP tables.

Insert statements can be used to populate these tables in the same manner as described
in the previous section.

Product Hierarchy User Groups

This is the final type of user group used to control access to the product hierarchy at
the highest level in the hierarchy. In the Data Security dialog box, the only level that is
visible is Department level. If imported or manually configured, the product hierarchy
may contain levels above Department. Products from the specified nodes can be
placed up to sub-class level in Top Graphical view and Display Style level in Front
Graphical view.

Manually Creating and Configuring the User Group
To create and configure this type of user group:

1. Create an appropriately named User Group in the User Groups tab of the
Functional Security dialog box accessed from the Security menu in the MSM
Administration module. Close this dialog box.

2. Associate the User Group with the pertinent department in the Products tab of the
Data Security dialog box accessed from the Security menu in the MSM
Administration module. Users will then have access to all products that are
children of that department.

This method works if the product hierarchy contains Department as the top level in
the product hierarchy. If the product hierarchy contains nodes above this level, for
example at Division, Group, or Company level, access to the product hierarchy can
only be configured directly in the database by inserting data into the AVITB_USER_
GROUP_PRODUCT_LINK table.

Scripting and Configuring the User Group

The data for creating user groups and assigning those user groups to stores is held in
the tables listed in Table 3-10.
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Table 3-10 Tables for assigning User Groups to stores

Table Description

AVTTB_PRODUCT_DEF Holds details of the product hierarchy with PRD_
ID as the primary key.

AVTTB_USER_GROUP Holds a list of user groups with USG_ID as the
primary key.

AVTTB_USER_GROUP_PRODUCT_LINK Links the AVTTB_STORE and AVTTB_USER _
GROUP tables.

Creating the User Groups

The simplest way of creating the user groups is to use a SQL insert statement to add a
user group for each node at the highest level in the product hierarchy.

Associating the User Group with the Department

To associate the user group with the department, use a simple insert statement to
populate the PRD_ID and USG_UD fields in the AVITB_PRODUCT_USER_GROUP_
LINK table. The UPL_PERMISSION_MAGSK can be set to a value of one.

Creation of Users and Associating with User Groups

One way of creating users is manually. Once created, they have to be associated with
the pertinent user groups.

Note: This section is equally pertinent for ISSC and ISSC Mobile.

Manually Creating Users

Creating the User

Users are manually created in the User Groups tab of the Functional Security dialog
box accessed from the security menu in the Administration module. In order to create
a user, first select a parent User Group. The newly created user will then be a member
of that user group. It is recommended that the Expiry Date for each user be set to a
date in the past. This forces a password change the first time the user logs on.

Manually Associating the User with Multiple User Groups

To manually associate the user with multiple user groups, copy and paste the user into
multiple groups in the User Groups tab of the Functional Security dialog box.

Scripting and Configuring the User Group

The data for creating users and assigning those users to user groups is held in the
tables listed in Table 3-11.

Table 3—-11 Tables for Assigning User Groups to Stores

Table Description

AVTTB_USER Holds details of the users with URD_ID as the
primary key.

AVTTB_USER_GROUP Holds a list of User Groups with USG_ID as the
primary key.
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Table 3—-11 (Cont.) Tables for Assigning User Groups to Stores

Table Description
AVTTB_USER_GROUP_LINK Links the AVITB_USER and AVTTB_USER_GROUP
tables.

Creating the Users
Users should be created by a method conforming to the retailer’s security policies.

Associating the User with the Required User Groups

To associate the user with the department, use a simple insert statement to populate
the USR_ID and USG_UD fields in the AVITB_USER_GROUP_LINK table.

Required User Groups

A summary of the required user groups for MSM and ISSC and ISSC Mobile is listed
in Table 3-12 and Table 3-13.

Table 3-12 MSM User Groups

MSM User Group Description

Admin Already configured with access for all modules.

Floor Layout Pre-existing user group intended for users laying out zones and
fixtures. Access to modules needs to be configured.

Merchandiser Pre-existing user group intended for users laying out products
and planograms. Access to modules needs to be configured.

Batch Process Suggested new user group (and user) useful in running batch
processes.

Table 3-13 Required ISSC and ISSC Mobile User Groups

Application  Required User Groups

ISSC For the most simple form of access, a single user group can be created with all
the required privileges. A member of that user group will have access to the
toolbar, all stores and floor plans at the required status, and all products in the
product hierarchy.

For maximum granularity, membership to a minimum of three types of user
group is required:

= Functional type user group for access to the toolbar.
= Store and file status type user group to allow the user to open a floor plan.

= Product type user group to allow the user to place products.

ISSC Mobile =~ Membership of a user group that allows the user access to a single store and
store status.
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Basic Data Configuration

Basic data configuration is data that is entered manually into the Administration and
Configuration modules to allow for the import of more complex or higher volume
data in a subsequent stage. The following topics are covered:

= Configuration Module

s Administration Module

Configuration Module

Options Tab

The Configuration module can be accessed from the File menu of the Administration
Module. Before doing so, all other dialog boxes must be closed. When opened from
here, SIs can access more tabs than when opened from the other MSM modules.

Two of these tabs are required for implementation purposes. Changes made in these
tabs will have a global effect. Accordingly, all modules other than the Administration
module must first be closed.

For details of where to find detailed information on the actions in this chapter, see
Appendix A, "Information Locations."

The radio button for units should be set to the same units (either metric or imperial) as
for the template database created when installing the application.

Directories Tab

The Directories tab is used to specify the location of folders used to hold physical files.
These paths are best specified as UNC paths as using mapped drives is more complex
and may cause difficulties for some users. Table 4-1 lists the locations.

Table 4-1 Folder Locations

Location Description

Common on File Server These files are accessible by all users. Two examples are the
folders holding the AutoCAD drawing (DWG) files used for
floor plans and the folders holding the DWG files (Fixture
Library) used to represent fixtures in the Planner module. It is
suggested a UNC path be used as this is simpler than mapping a
drive on every user’s computer.

Local on User’s Computer  These are files specific to the user. An example is the help files
which must be stored locally.
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Note: Local files must be in the same physical location on each user’s
computer because the database only holds a single path to each local
file. When MSM is installed, a standard set of folders are installed at

the same time.

To set the location of the folders:

1. Create any physical Windows folders required on the file server.

2. Map to those and the local directories from the Directories tab.

Table 4-2 lists the common directories.

Table 4-2 Common Folders on File Server

Folder/Directory

Description

Archived Files The directory that the imported files are moved to if the
archiving option is in use. Required by Data Importer.

Export Files The location where the files are exported to, for example, images
from the Snapshot option in the Merchandiser module.

Floor Plan Publish Directory which acts as the root for the location to which the

floor plans are published.

Image Capture

Directory for images that will be imported into the software, for
example, images for association with products. Image capture
could also be a local directory, but it is generally simpler to have
a single, common directory on the file server.

Image Label

Directory for images that can be added to the labels associated
with fixtures in the Merchandiser environment.

Image Root

This is the root directory for images used for photo-realistic
representations of products (product images). As product
images are added, the hierarchy below the image root is
modified.

Import Files Location from which files are imported. Data Importer looks for
the files it reads in this location.

MSM Directory that holds standard blocks used by Oracle Retail
Macro Space Management.

RF Bin This holds files that have been marked for deletion in Store
Manager and moved from the Store Root directory.

Planogram Publish Directory which acts as the root for the location to which

planograms are published.

Planogram Root

Root directory for planograms imported from third-party
software. It is no longer in use. The location is now specified by
the DEFAULT_IMPORT_DIR system variable.

Sounds

Directory for .wav files that are used to generate warning or
alert sounds used in ISSC.

Store Root

Root directory for the directories and files that make up the
hierarchy specified in Store Manager. Clusters are containers for
stores sharing a common characteristic. They exist only in the
database and are not associated with any child directories below
the store root.

Textures

Directory for Textures. Used for specifying the textures for walls,
ceilings, and so on, in Merchandiser.
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In addition, some custom directories need to be created on the file server. These
include folders for the fixture drawing file libraries, Planner prototype AutoCAD
DWG drawing, and any title blocks. These are copied locally when MSM is installed.
Moving them to a central location ensures that updating them only has to be done
once.

Table 4-3 lists the folders that need to be local.

Table 4-3 Folders on the Local Machine

Folder Description

BMP This directory is used for the AutoCAD toolbar button bitmaps
that appear in the toolbars in the Planner environment.

Help Folder for the help files used by MSM. Must be local for them to
work.

Log files Log files created by the application to record events and issues.
It should not be a network directory due to potential file locking
issues.

Root Root directory for the local application folders.

Working Directory for temporary files, including temporary graphics

images, created in Merchandiser.

As well as the standard folders, others may need to be created. For example, parent
and child folders may be needed to hold the different sort of fixture blocks created in
Fixture studio. These should also be created on the file server and the pertinent paths
assigned in the Directories tab. These directories then become available in the
Category tab of the block Details dialog box in Fixture Studio.

In addition to those blocks, some blocks installed locally with each MSM installation
are also best moved to the file server. These blocks are discussed in "Move Information
to the File Server.".

Move Information to the File Server

Some files are initially installed locally. Although the application will work
satisfactorily, moving a set to a location on the file server means that upgrading the
application becomes simpler. Table 44 lists the files.

Table 4-4 File Server Information

Data Description
Files in the MSM Blocks When MSM is installed, it includes blocks used for system
directory purposes such as bay numbering and aisle annotation. These can

be found as children of the C:\Oracle

Retai \MSM\MSMBIlocks directory; one folder holding the
blocks required for an imperial database and one for a metric.
The pertinent set should be copied over to the File Server.

Prototype Drawing This is a DWG file used to create blank floor plans in Planner. It
is installed in the C:\Oracle Retail\MSM\Data Files directory.
There are two DWG files, one for a metric database and one for
an imperial one. The pertinent prototype drawing should be
copied over to the File Server.

The prototype drawing defines the default settings for a blank
floor plan including the snap and grid settings together with the
default text and dimension styles.
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Table 4-4 (Cont.) File Server Information

Data Description

Title Blocks When MSM is installed, default title blocks are provided. These
can be found as children of the C:\Oracle
Retail \AMSM\MSMBIlocks directory; one folder holding the
title blocks required for an imperial database and one for a
metric. The pertinent set should be copied over to the File
Server.

The Windows folders for these on the file server should be created with an identical
name to the original. The new path can then be mapped in the Directories tab of the
Configuration module. Using this method avoids the need to individually remap each
block to the new directory. A set of files can then be pasted into the pertinent folders.
Table 4-5 lists the actions that are required after moving the files.

Table 4-5 Actions Required after Moving Files

Data Description

Files in the MSM Blocks The original path for the MSM directory will be a local drive.
directory This should be changed to that on the file server.

Prototype Drawing Open the Configuration module. In the Files tab, set the path to

the folder on the file server.

Title Blocks The original path for the default title blocks will be a local drive.
This should be changed to that on the file server.

The precise directory the MSM blocks and default title blocks will be held in depends
if they are metric or imperial. A directory for each type can be found as a child of the
MSM Blocks directory.

Note: When upgrading, carry out a difference check between the
blocks supplied with the upgrade and the existing blocks to see if any
have changed.

The Profiles Tab

4-4 Oracle Retail

The profiles tab enables users to switch between profiles. Each profile holds a specific
collection of settings in the Configuration module. Each profile can be exported.
clicking the Export button will write files containing the current profile into the Export
directory specified in the Directories tab of the Configuration module.

Some of the settings in the Configuration module are written to the database - for
example the names of and paths to the specified directories. Other settings are written
to the registry on each computer. An example of this is the path to the AutoCAD
prototype drawing used to create blank floor plans in the Planner module.

It is suggested that one computer is configured with the appropriate settings in the
Files, Zones, Fixturing, Merchandising and Merchandiser tabs. Many of these settings
can then be added to other MSM computers by:

1. Clicking Export on the Profiles tab of the Configuration module. This will write
two .reg files to the specified export directory.

2. Copying the .reg files to the computer it is desired to import the settings into.

3. Double clicking the .reg files to write the contents to the registry on that computer.
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Administration Module

The remaining basic data configuration is carried out in the Administration Module.

Calendar Data

The Calendar allows data to be associated with specific time periods. An example of
this is the import of financial data for KPIs. Calendar data can be added or modified
by one of three means:

= Manual entry in the Calendar dialog box accessed from the General menu.
s Data import. This requires configuring an import.
= Add the data directly to the database using a SQL insert statement.

As some functionality (such as KPIs) reference the AVITB_CALENDAR table, a
minimum of one entry is required in the table. This is the period ALL covering 1st
January 2000 to 31st December 2099.

Note: The default calendar provided refers to historical dates. This
can be deleted.

Zone Definitions

Zones are used to describe the physical part of a store allocated for particular retail
purposes. (An alternative name for zones is departments). Zones are of three general
types. These types are defined in the Zone Types dialog box accessed from the
Planning menu. In the database this is the ZNT_ID in the AVTTB)ZONE_TYPE table.
Table 4-6 lists the zone types.

Table 4-6 Zone Types

Zone Type Description

Internal Area There can only be one zone of type Internal Area. This is used to determine
the total area used for retailing for reporting purposes.

Department These are the best zones to be used for reporting purposes as fixtures are
only ever allocated to one Department level zone.

Other Zones of type Other serve two broad purposes: as containers in the
hierarchy for placeable zones, for example, Sales/Non-Sales and as
sub-departments within departments for finer granularity of reporting.

Note: ISSC floor plans require zones of type Department to be
present before they can be opened. More specifically, the ZNT_ID
must be 0 for the zone to be recognized in ISSC

Factors to consider in Setting up Zones

There are a number of factors to consider before setting up zones. Table 4-7 lists the
factors.
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Table 4-7 Factors when Configuring Zones

Factor Description

Layers Clash functionality identifies if zones of the same general type (for example,
Department zones) are overlapping. This is to prevent double counting of the
floor area in a store. The clash functionality only works for zones on the same
layer. Default layers are provided for the zone types in the template
database.

If additional types are created, for example, for non-sales areas such as the
space allocated to aisles, more layers need to be created for the new zone
types to go on. Creating those additional zone types and requisite layers is
outside the scope of this implementation guide.

Colors and Zones can be assigned both a color and a hatch pattern. These can be used to
Hatch Patterns  distinguish one zone from another.

Zone Codes Zone codes are unique codes primarily used for importing and updating
zone definitions. If associated with formation from another database, they
can be used as look-ups to create primary keys in MSP.

Creating a Zone Definition
To manually create a zone definition:

1. Open the Zone Definitions dialog box from the Planning menu.

2. Highlight the node in the zone hierarchy that will be the parent for the zone about
to be created.

3. Click Add Zone on the toolbar. This brings up the Add Zone Description dialog
box. Add the following information:

= Zone name and description.

= Zone type from the drop-down list.
= Hatch style and color.

s Icon from the drop-down list.

= Zone code (if required).
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Initial Fixture Studio Setup

This chapter describes the preliminary setup in Future studio. It enables users to place
and test fixtures and gondolas, but not to plan a full store. The following topics are
covered:

s Initial Configuration

= Remap System Blocks

s Create Fixture Hierarchy

s Create Example Fixtures

s Create Gondola Hierarchy
s Create Example Gondolas

For details of where to find detailed information on the actions in this chapter, see
Appendix A, "Information Locations."

Initial Configuration

By default, Fixture Studio does not load block information automatically on startup. To
load the blocks automatically on a specific machine, open the Options dialog box from
the View menu, check the Automatically read blocks on start option, and click OK.
The blocks will then load automatically the next time Fixture Studio is started.

Remap System Blocks

Chapter 4, "Basic Data Configuration" covered moving the system blocks to a location
on the File Server. This makes them available to all users from a common location and
thus facilitates updating. In the template database, these blocks are mapped to the
directory on every user’s local drive.

The simplest way to remap the system blocks is to create an identically named
Windows folder on the file server as exists on the local drive. After copying the files,
open the configuration module from the Administration module and reset the
directory path to the folder in the Directories tab.

Create Fixture Hierarchy

The aim of the fixture hierarchy is to provide a framework for arranging the
substantial number of fixtures required for store planning in a logical manner so they
can readily be located in the Object Browser. This hierarchy can be brought in using
the pre-configured import in the Data Importer module.
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It can also be created manually in Fixture Studio. To do this, highlight the required
parent group in the fixture hierarchy and click Add Group on the toolbar. In the
Group dialog box, enter the Description and select an appropriate icon from the
drop-down list. Click OK. Continue until all the required fixture groups have been
added.

Create Example Fixtures

The SI will have to create a number of fixtures. These will normally be a subset of the
retailer’s fixtures suitable for creating a gondola. The fixtures and gondola are
required to create a floor plan for further implementation tasks.

To create the fixtures:

1. Create the block in the Planner module (if not preexisting as a raw AutocAD
block).

2. Read the AutoCAD block into the Fixture Studio module.

3. Assign MSM properties and save the block in Fixture Studio. These MSM
properties are a series of settings assigned to the block that determine how it
behaves when inserted into a floor plan. These settings may also determine other
facets of behavior - such as if the block can accept merchandise or not.

An alternative to assigning MSM properties manually in Fixture Studio is to
import the properties directly into the database using the Fixtures predefined
import in the Data Importer module.

4. Save the block. This must be done in a specific way.

s Fixture Studio must be connected to the Planner drawing containing the
AutoCAD block for the fixture.

s In the Save dialog box both the drawing and the database must be selected as
destinations.

This will result in the following:

m The data for the fixture will be written back to the database. (Until then it is
only saved locally in Fixture Studio).

s XData is written from fixture studio into the raw AutoCAD block. This data is
used by Planner and is not accessible to users.

= A copy of the block containing the XData is written into the directory specified
in the Category tab of the Block Details dialog box in Fixture Studio. This copy
of the block will be used every time the block is placed in a floor plan.

Naming Conventions

Some operations (such as creating gondolas) are only possible if a naming convention
is used for blocks. An example of a naming convention is:

Block_Type_LengthxDepthXHeight
This gives a family of blocks of different sizes names in a logical way. Following is an
example showing three blocks with names according to a naming convention:

Chiller_36x24x73
Chiller_ 48x24x72
Chiller_ 48x24x96
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Creating the Block in the Planner Module

These steps are for a single block. The process can be carried out in bulk if required.

To create the block in the Planner module, see the following sections:

Prepare the AutoCAD Drawing

To create blocks with 2D /3D functionality, two layers should be created in the drawing
called 2D and 3D. These are in addition to the standard Layer 0.

Create the Fixture

To create the fixture, draw an outline representing the footprint of the fixture on Layer
0. Select the outline. Open the Properties dialog box and set the properties shown in
Table 5-1.

Table 5-1 Basic Fixture Properties

Feature Purpose

Change the layer to 2D Required for the 2D /3D functionality to work.
Set the color to By Block Required for KPIs to work.

Set the lineweight to By Block Required for thicken as a highlighting option.

Draw the three dimensional representation of the fixture on Layer 0. Select the outline.
Open the Properties dialog box and set the properties shown in Table 5-2.

Table 5-2 Basic Fixture Properties

Feature Purpose

Change the layer to 3D Required for the 2D /3D functionality to work.
Set the color to By Block Required for KPIs to work.

Set the lineweight to By Block Required for thicken as a highlighting option.

Select both the 2D and 3D parts of the fixture and turn it into a block using the
AutoCAD BLOCK command. Enter a suitable block name for the Block Definition,
specify the insertion point, and click OK to create the block.

Read the Block into Fixture Studio

To read the block into Fixture Studio, ensure the drawing containing the block is the
active drawing in the Planner module. Select Connect to AutoCAD from the File
menu in Fixture Studio. This links Fixture Studio to the active drawing in Planner. Sls
should remain connected to AutoCAD while registering and saving blocks. Some of
the requisite functionality is only available while connected.

Select Read Blocks from the File menu. This brings up the Read Block Definitions
dialog box. Set the source to Merge. This reads in any block definitions from the
Planner drawing that are not in the database. Click OK to read in the definitions.
These appear in the Fixture Hierarchy.

Assign MSM Properties to the Block

The next step is to assign properties to the block. These are used by many pieces of
MSP functionality during the store planning process:

1. Assign the fixture to the correct node in the Fixture Hierarchy.
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2. Assign the MSM properties.
3. Save the Block within Fixture Studio.

Assign in the Fixture Hierarchy

When first read into Fixture Studio, the Blocks appear in the Fixture hierarchy. To
assign them to a specific Fixture Group, highlight the fixture and then drag and drop it
onto the icon representing the Fixture Group.

Assign MSM Properties

A range of MSM properties need to be assigned. Only the more important ones are
described in the following tables. This is done in the Block Details dialog box brought
up by right clicking on the block in the Fixture Hierarchy and selecting Edit Block.
Some basic properties that can be assigned are listed in the following tables.

Table 5-3 Basic Settings for Categories Tab

Setting Description

Retail Type Typical values for equipment are Fixture, Fitting, or
Shelf. If the SI is unfamiliar with the available types,
they can use the provided wizard.

Can Populate with Display Style Set these checkboxes as appropriate for the type of

Can Populate with Placeholder equipment.
Accepts Secondary Equipment
Directory Set to the appropriate directory. The list of available

directories is configured in the Directories Tab of the
configuration module accessed from the File menu in
the Administration module.

Status Set as appropriate.

Effective Date These are the dates the equipment is scheduled to come

Expi into and be withdrawn from service. Set as appropriate.

xpiry Date

Area Calculation Directions Set as appropriate for the equipment. These are used for
reporting purposes.

Reporting Option Flags Set as appropriate. If fixtures are to annotate in a floor
plan, the Include in Fixture Annotation flag must be
set.

Note: At present the expiry date defaults to 1899. This should be set
to a date in the future - typically 31st December 2099.

Table 5-4 Basic Settings for Insertion Tab

Setting Description

Layer Select an appropriate layer for the block. The default layers
provided are FIXTURES, FITTINGS-FITTING, and SHELVES.

Level Select an appropriate level for the block. Fixtures typically go on
Floor level, shelves on Undefined.

Insertion Position This must exactly match the point chosen when the block was
created with the BLOCK command in Planner.

5-4 Oracle Retail Macro Space Planning Implementation Guide



Create Example Fixtures

Table 5-5 Basic Settings for Size Tab

Setting Description

Dimensions Set the dimensions for the block. As Fixture Studio is connected
to the Planner drawing, this can be done by clicking Calculate.

Table 5-6 Basic Settings for Connections Tab

Setting Description

Connections Assign connection points to the block. The simplest way of
doing this is to click Wizard.

Table 5-7 Basic Settings for Parts Tab

Setting

None required for basic implementation.

Table 5-8 Basic Settings for Fixture Tab

Setting Description

Product Block Select a product block. This is used to show the presence of
merchandise in the Planner module. The default block provided
for an imperial database is I PBASE__. For a metric database
the equivalent block is P_BASE__.

Table 5-9 Basic settings for UDA Tab

Setting

None required for basic implementation.

Table 5-10 Basic Settings for Fixture Tab

Setting Description

Fixture For a basic implementation, select the Fixture style.

Shelf Equipment of type Shelf also requires a shelf style to be
assigned.

Table 5-11 Basic Settings for Merchandisable Areas Tab

Setting Description

Offset 1 This generally needs small X and Y offsets to allow for the
thickness of the fixture.

Offset 1 This can generally be left at 0,0,0 for simple fixtures.

Note: The merchandisable area is the area taken up by a product on
the fixture. It is defined by two offsets, one from the lower left corner
of the fixture and one from the upper right corner.
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Table 5-12 Basic Settings for Shelf Tab

Setting

None required for basic implementation.

Table 5-13 Basic Settings for Preview Tab

Setting

None required for basic implementation.

Note: No graphics will be visible unless a 3DS file has been created
for the block. (From the File menu, select Create 3DS Files.)

Save the Block within Fixture Studio

To save the block within fixture Studio, click OK on the Block Details dialog box. The
information is saved locally and not yet written back to the database.

Save the Data to the Database and AutoCAD Block

To save the block to the database and write MSM specific information to the DWG
block, open the list of blocks and highlight the required fixture. At this stage, the icon
should be red (showing that data has been changed) and it should have a negative ID
(for example -1). Next, select Save Blocks from the File menu. This brings up the Save
Block Definitions dialog box. Make the following selections:

= Set the destination to both Database and Drawing,.

n  Select the Add New Definitions, Enforce Save, Only Save Selected Blocks, and
Write Block Files options.

On clicking OK, the data is permanently written to the database, xdata is embedded
into the DWG file, a copy of the block is written to the directory specified in the
Category tab of the Block Details dialog box, and a confirmatory dialog box appears.
The icon for the block turns to green and the ID changes to a positive number. The
block information has been written to the database.

Note: Multiple fixtures can be saved by using multi-select in the list
of unsaved fixtures.

Create Gondola Hierarchy

The aim of the gondola hierarchy is to provide a framework for arranging the
gondolas required for store planning in a logical manner so they can readily be located
in the Object Browser.

It can be created manually in Fixture Studio. To do this, highlight the required parent
group in the gondola hierarchy and click Add Group on the toolbar. In the Group
dialog box, enter the Description and select an appropriate icon from the drop-down
list. Click OK. Continue until all the required gondola groups have been added.

5-6 Oracle Retail Macro Space Planning Implementation Guide



Create Example Gondolas

Create Example Gondolas

The SI will have to create an example gondola from the subset of the retailer’s fixtures.
This should be configured to represent a gondola in actual use by the retailer. This
gondola is required to create a floor plan for further implementation tasks.

Note: The Fixture Studio User Guide contains two worked examples
on how to create a gondola.
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Overview

Data Import

The chapter describes the import of bulk data from other systems. The following topics
are covered:

s Overview

= Configuration in the Administration Module

= Importing the Store Hierarchy and Information
= Importing Products and Planograms

= Product and Planogram Import using ODI

This section covers configuring the bulk import of data into MSM. This is done by
importing data from the retailer’s other systems. Bringing in the data regularly when
MSP is in service at the retailer is covered in Chapter 9, "Batch Processes.".

For details of where to find detailed information on the actions in this chapter,
Appendix A, "Information Locations."

Data Import Tools

There are three basic forms of import tool.

Data Importer

Data Importer is an MSM module. It can be used to import the simpler forms of data
during the implementation process. It is not efficient at importing large volumes of
complex data and is thus not suitable for regular overnight batch processes.

Oracle Data Integrator (ODI)

This is Oracle’s Extract-Transform-Load (ETL) tool. Scenarios are provided to assist in
the import of planogram designs. In addition, SIs can configure ODI for other forms of
data import.

Third Party ETL Tools

If the retailer already uses another ETL tool, it can be configured for import purposes.
Configuring third-party software is outside the scope of this document.
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Full or Delta Imports

There are two possible forms of imports: full or delta. Full imports bring in the entire
set of data; delta imports just any changed data. Full imports are necessary to populate
the MSP database when first importing information. After that, delta imports are the
most efficient way of importing data within a restricted time window for large
volumes of data.

Next IDs and the AVTTB_NEXTID Table

CSV Files

The database contains a table called AVITTB_NEXTID. This contains the primary key
for the next entry in a number of tables and is used to help with multi-user access to
the record of the next available primary key for those database tables. The AVTTB_
NEXTID table needs to be updated after each data import. There are several ways of
doing this including the following:

= Manually from the Tools menu in the Administration module.
= By using the Post SQL option in Data Importer.
s By calling the AVISP_UPDATE_NEXT_ID stored procedure.

Failure to update the AVITB_NEXTID table can result in referential integrity problems
when the functionality is next used.

In order to import using Data Importer, a CSV file containing the pertinent
information must be created and placed in the Import Files folder specified in the
Directories tab of the Configuration module. Data Importer does not come with
example CSV files. The sequence of data for the columns of this CSV file can be
determined from the Import Definition in Data Importer and an appropriate file
created of data for import. The format of the file can be determined from the
pre-configured import in the Data Importer module - further information is outside of
the scope of this document.

Configuration in the Administration Module

Prior to importing planograms via the pre configured ODI scenarios or via a third
party ETL tool, three things need to be configured in the Administration module:

= Mapping the fixture, shelf styles and product used in third-party planogram
software to map the fixture, shelf and product styles used in MSM. For a basic
implementation, these can be mapped to the default styles provided.

s Defining the default items of equipment if an item of equipment being imported in
the planogram definition that does not exist in the MSP database. This may require
creation of the required default items of equipment in Fixture Studio.

= Setting up the system variables described in Table 6-1.

Planogram Import Styles

The purpose is to map the fixture and shelf styles used by a third-party planograming
tool to the fixture and shelf styles used by Macro Space Planning. This means MSP can
use the style relationships from the third-party planograming tool to validate the
placement of the shelf objects when they are placed onto the parent fixtures. For
instance, a shelf may be identified in the other system using a code "1". MSM will then
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map that to a particular style, and then identify a block that has that style and the
specified size.

A default block is also assigned for each style, so that if the specific block in the
planogram import does not exist in the MSP database, an alternative is assigned.

This data is configured in the Planogram Import Styles dialog box accessed from the
Merchandising menu in the Administration module. To configure this information:

1. Enter the name of the third-party planogram software by selecting options from
the tools menu. The requisite name can then be selected from a drop-down list.

2. Select the required default block of equipment from the drop-down list. These
blocks must first have been created and defined in Fixture Studio:

s Ifno block of the required type is available, the drop-down list is blank.

s Ifnoblock is specified, during planogram import, the block defaults to that
specified in the DEFAULT_IMPORT_FIXEL_BLK_ID or DEFAULT_IMPORT_
FIXTURE_BLK_ID system variable.

Note: This may require creating the necessary default blocks in
Fixture Studio first.

3. For each MSP style option, enter the corresponding style from the third-party
planogram software. Each MSP option must have a corresponding style entered
before the dialog box can be saved.

System Variables for Planogram import

There are a number of system variables that need to be configured prior to planogram
import. These define the default items of equipment to be used if no default item of
equipment has been defined in the Planogram Import styles dialog box. Before these
system variables can be configured, the appropriate items of equipment must first be
registered in Fixture Studio. The system variables are configured in the System
variable dialog box accessed from the General menu in the Administration module.

Other system variables determine the default product blocks that are used if the
information is not included in the import, together with other information such as the
default material to assign.

Table 6-1 lists the system variables.

Table 6-1 System Variables for Planogram Import

System Variable Description
DEFAULT_IMPORT_BLK_ID Default product blocks.
DEFAULT_IMPORT_DIR Default import directory.
DEFAULT_IMPORT_FIXEL_BLK_ID Default shelf

DEFAULT_IMPORT_FIXEL_STYLE_ID Default style assigned to the default shelf.

DEFAULT_IMPORT_FIXTURE_BLK_ID Default fixture.

DEFAULT_IMPORT_MAT_ID Default material to be assigned.

DEFAULT_IMPORT_PRODUCT_BLK_ID  Default product block for imported products.
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Importing the Store Hierarchy and Information

The most efficient way of bringing store information is by importing data. The Data
Importer module contains a predefined import for stores and their hierarchy.
Alternatively, the SI can configure ETL tools (such as ODI) to import the information.

Overview of Importing Store Information using Data Importer

Data Importer comes with a pre-configured import for store information. This includes
a store hierarchy and store information, such as address, and User Defined Attributes
(UDA) information.

The store hierarchy (clusters) imports with the following structure:
= Business

s Continent

= Country
= Region
s District

Store level information that is imported includes address and UDA information. If
UDAs are to be imported, these must first be configured in the Administration
module. This is done using the User Defined Attributes dialog box accessed from the
General menu.

Note: For information on how to configure UDAs, see the Oracle
Retail Macro Space Management Administration Module User Guide.

Running the Import via Data Importer

A CSV file containing the pertinent information must be created and placed in the
Import Files folder specified in the Directories tab of the Configuration module
accessed from the File menu of the Administration module. Once the CSV file is in the
Import Files folder, the data import can be run by selecting the Stores option in Data
Importer and clicking Import Data. After the import has run, the results can be seen
by viewing Data Importer’s Import Log and Import Error Log.

Actions after the Data Import

After the store hierarchy has been imported, the data exists in the database. However,
physical files need to be created before the functionality can be used. Table 6-2
describes the required physical folders. These may well be created by using a tool such
as a DOS batch script.

Table 6-2 Physical Folders Required

Hierarchy Object Description

Clusters Clusters exist only in the database as containers for stores sharing a
common characteristic. As such, no Windows folders are required.

Stores Each store requires a Windows folder underneath the Store Root defined
in the Store Root directory specified in the Directories tab of the
Configuration module accessed from the File menu of the
Administration module. The path for each directory is specified in the
AVTTB_STORES table in the database.
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Table 6-2 (Cont.) Physical Folders Required

Hierarchy Object Description

Floors and Revisions When the store hierarchy has been imported, it is possible to create a

default floor and revision for each store below the store root, the
revision containing a blank DWG file. Alternatively, these can be
manually created by floor planners using Store Manager.

Note: The DWG file is based on the Prototype Drawing specified in
the Files tab of the Configuration module. This is accessed from the
File menu in the Administration module. This setting is stored locally
in the registry on each computer.

Importing Products and Planograms

The next stage is importing products and planograms. Typically, this is a three stage
process:

1.

The Product Hierarchy is imported using Data Importer. This hierarchy must be in
place before planograms and their associated products can be imported.

The planograms designs (including their associated products) are exported to an
XML file using an ETL tool.

The ODI (with its pre-configured scenarios) is used to import the planograms and
their associated products.

Note: Data Importer contains a pre-configured import for SKUs and
Display Styles. For implementation purposes, this provides an
alternative to importing the products with the planogram design
information.

Importing the Product Hierarchy

The product hierarchy is a prerequisite for importing planograms. The planogram
designs only contain information on the SKUs they contain and not the hierarchy to
which they belong. The product hierarchy has to be present so that imported products
can be assigned to their correct node.

If the product hierarchy is imported using Data Importer, the pre-configured hierarchy

1S:

Division
Department
Class
Sub-Class
Style

Ttem

SKUs are added at the item level by the Planogram Import process, although this
could be done by Data Importer for the initial import.
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Running the Data Importer Import(s)

A CSV file containing the pertinent information must be created and placed in the
Import Files folder specified in the Directories tab of the Configuration module
accessed from the File menu of the Administration module. Once the CSV file is in the
Import Files folder, the data import can be run by selecting the Product Hierarchy
option in Data Importer and clicking Import Data. After the import has executed, the
results can be seen by viewing Data Importer’s Import Log and Import Error log.

Product and Planogram Import using ODI

Oracle provides a solution by configuring ODI to import planogram designs from a
pre-defined XML file.

Data Import using ODI

ODl is configured to import planogram definitions from an XML file. This XML file is
typically generated by an ETL tool. The SI has to perform two steps:

n  Create the XML file (typically by use of an XML tool).

= Import the data in the XML file into the MSP database by using ODI and the
pre-configured scenarios it is provided with.

Creating the XML File

Many planogram definitions are created in third-party software and imported into the
MSP database. Full planogram designs contain information on parent fixtures,
equipment (fixels), and products. Creation of this XML file is an SI responsibility. The
structure of the XML file is described in an Oracle white paper called Planogram Import
available from My Oracle Support.

Once generated, the XML file has to be placed into the directory designated as the
source from which the XML file is imported.

Importing the XML File

The XML file can be imported into the MSP database using a pre-configured
installation of ODI. The full details are covered in the Oracle ODI Planogram Import
User Guide, Volume 1. Once configured, the initial import can be run manually. After
the initial import has populated the database with the planogram information, it is
generally only necessary to import information on new, modified or deleted
planograms.
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Initial Planner Setup

This chapter explains how to configure basic aspects of the Planner module. Once
configured a basic floor plan can be created using

= System Variables

»  Create Access for Architectural Plans
s Configuring Layers

s Creating a Temporary Floor Plan

For details of where to find detailed information on the actions in this chapter, see
Appendix A, "Information Locations."

System Variables

The system variables are configured in the System Variable dialog box accessed from
the General menu in the Administration module. Planner must be stopped and
restarted before any changes in these system variables take effect.

Store Manager

There are two system variables that affect the default Publish Date and Effective Date
provided when a floor plan is first set to Authorized status. These default dates can be
modified by the floor planner if required. These Publish and Effective dates must be
consistent with the retailers business processes and should be set after consulting the
retailer about how fast the required actions can be executed within their organization.

»  The Publish Date is when the floor plan will be distributed to the stores and the
supply chain will be set in motion to provide the required items at the specific
date.

»  The effective date is when the floor plan will go into service at the store with
planograms being replaced or reset and so on.

The System Variables are:

PUBLISH_DATE_LEAD_PERIOD

This system variable determines the default number of days from the current (today’s)
date the floor plan will be published. The system variable setting is currently 0 - it will
default to today’s date. A typical value might be between 14 - 28 days, resulting in the
floor plan being published 2 or 4 weeks after it is authorised.
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EFFECTIVE_DATE_LEAD_PERIOD

This system variable determines the default number of days from the Publish Date the
floor plan will be made Current. The system variable setting is currently 0 - it will
default to today’s date. A typical value might be between 14 - 28 days, resulting in the
floor plan being made effective 2 or 4 weeks after it is published.

Note: The EFFECTIVE_DATE_LEAD_PERIOD system variable is
cumulative with the PUBLISH_DATE_LEAD_PERIOD system
variable. If both are set to 14 days, the Effective Date will be set to 28
days ahead of today’s date.

Synchronisation

Planner holds floor plan information in an AutoCAD drawing. The information held
in the database can differ from this drawing for a number of reasons including
changes made in the MSM Merchandiser module and in ISSC. A series of system
variable settings determine whether those changes are synchronised manually or
largely automatically.

A set of default settings are provided which will suffice for most retailers. However,
these can be modified to suit the requirements of a specific business process. When
synchronisation has been configured, the SI should give the retailer pertinent notes so
that the retailer can train its staff accordingly.

The system variables are:

AUTOSYNC

This system variable is used to specify whether a DWG floor plan is automatically
synchronised when it is opened. The options are:

Table 7-1 AUTOSYNC System Variable Values

SV Value Effect

0 Do not Auto-Synchronize.

1 [Default] Prompt when Auto-synchronization is required.

2 Auto-Synchronize automatically when the floor plan is opened.

DYNAMIC_SYNC

This system variable determines whether changes made to a floor plan using
AutoCAD commands (as opposed to MSM commands) are automatically written to
the database. Leaving this set to On is preferable as it removes the need for a user to
remember to manually synchronize the floor plan after making changes. It also
ensures that summary views and reports are up to date.

Table 7-2 DYNAMIC_SYNC System Variable Values

SV Value Effect

0 Off - manual synchronisation required.

1 [Default] On - results of many AutoCAD commands written to the database.
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SYNC_SETTINGS

This system variable determines whether to save user specific defaults for the
synchronisation options or to use the default options. If the defaults are used, they can
be specified in the SYNC_DIRECTION and SYNC_OBJECTS system variables. These
them become the default options for the user when manual synchronization is used.
The options for the SYNC_SETTINGS system variable are:

Table 7-3 SYNC_SETTING System Variable Values
SV Value Effect

0 Use default options.

1 [Default]  Use user specific options

SYNC_DIRECTION and SYNC_OBJECTS

The SYNC_DIRECTION system variable holds the default direction for
synchronisation in the Synchronisation dialog box accessed from the File men in the
Planner module. This is set to a default of 0: Match the drawing.

The SYNC_OBJECTS system variable specifies the objects that are to be synchronised.
It is a bitwise system variable set to a default of 29. This will synchronize fixtures,
products, other blocks and zones.

Table 7-4 Bitwise Values for SYNC_OBJECTS System Variable

Bitwise Value Description

0 No Defaults.

1 Synchronize Fixtures.

2 Synchronize Shelves.

4 Synchronize Products.

8 Synchronize Other Blocks.

16 Synchronize Zones.

32 Synchronize Views.

64 Synchronize Lights. (Not currently in use).
128 Synchronize Notes/Markups.

256 Synchronize Aisles.

The default value of 29 is made up of (1) Fixtures, (4) Products, (8) Other Blocks and
(16) Zones.

Create Access for Architectural Plans

Architectural plans can be in two formats; DWG and DWE. MSP can use both formats,
ISSC can only use DWF files. Architectural plans are used to show the position of
physical structures such as walls services such as electrical power and lighting as an
aid to store planning. The retailer may already have these architectural plans - they
need to be made accessible to MSP. There are two ways this could be done:

= Setting up a mechanism to publish architectural plans from Raw AutoCAD to a
folder that MSM users have access to.
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s Giving MSM users access to the folders the architectural plans are currently
published to.

If no existing architectural plan is available, then it is suggested one be created
showing the basic building shell. This can then be used to ensure zones, equipment
and signage are correctly located relative to doors, windows and walls.

The retailer will also need to have a method for identifying architectural plans that are
updated - an architectural plan from before a store refurbishment may be different
from the one after it.

Configuring Layers

Layer Aliases

When fixtures and fitting are placed, they initially take up the color of the layer they
have been assigned to when they are configured in Fixture Studio. By default all these
layers have the same initial color. It is useful for some of the layers to be given a
different color so that the type of object on them can be easily identified. Three of the
most common layers that have their color changed for this purpose are the Fixtures
and Fittings layers. for equipment and the Aisles layer for aisles.

To change the color of a layer:
1. Select Layer Aliases from the Format menu.

2. Select a layer from the list. Click on the color for that layer to modify it. A color
pallet will appear.

3. Select a color on the color pallet and click OK. The color for the layer will change.
4. After all the required colors have been changed, select Exit from the File menu.

5. Click Yes in the confirmatory dialog box to save the changes back to the database.

Note: The color of text is controlled from the Text Styles dialog box
in the Administration module. Changes in the Layer Aliases dialog
box have no effect.

Layer Aliases map the AutoCAD layers in a Planner (AutoCAD) floor plan to the
layers used in Merchandiser and in ISSC.

Layer Standards

Layer Themes

Layer standards are where the layers used in Planner floor plans are named according
to a pre-determined set of rules. The database allows layer names from several layer
standards to be stored - although only one layer standard can be in use at one time.
Each layer standard is thus a logical grouping of layer names.

= Each Layer Alias must map to a Layer Name for each standard.

See the Oracle Retail Macro Space Planning Data Model for more information.

Layer Themes are ways of setting a pre-configured set of rules for which layers are
turned on or off, together with information on line weights, transparency and so on.
These are then reference by the Printing and Publishing processes.
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These are not fully configured in the template database and some work must be done
during implementation.See the Oracle Retail Macro Space Planning Data Model for more
information

Creating a Temporary Floor Plan

Creating a temporary floor plan is useful to configure some of the functionality in
Planner and ISSC. As an alternative, one of the retailer’s existing floor plans can be
imported into MSM and used. Actions than can be carried out using it include:

Completing the configuration of the default Title Blocks.
Configuring Text Styles.

Configuring Floor Plan Publishing.

Manually Testing Floor Plan Publishing.

Manually testing Update Status.

If a temporary floor plan is required, create it as follows:

Select Cluster and Store

The store hierarchy was imported as part of the data configuration process. This will
have created entries for the store in the database. As a follow up to the data import
process, physical windows folders should have been created under the store root for
each store. Creating a temporary floor plan will not be possible if this Windows folder
is absent.

1.

@ o » w N

Open Store Manager.

Select a cluster and a store in the store hierarchy.

Add a floor to the store.

Add a revision to the floor.

A folder structure is created below the store root on the file server.

Add a blank floor plan to the revision. (If the Add Proposal Drawing option is
checked in the Add Revision dialog box, this will have been done when the
revision was created).

Note: Clusters will not have a physical folder created under the
store root. Clusters are containers used to group together stores shar-
ing a common characteristic.:

Associate an Architectural Plan

Associate an architectural plan with the store.

1.
2.

Navigate to the floor created for the store in Store Manager.

Use the Associate Architectural Plan option on the toolbar to add the architectural
plan to the floor. This makes it available to all floor plans that are children of that
floor.

Navigate to the revision and open the floor plan.
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4. In Planner, use the Add Architectural Plan option from the Insert menu to add
and architectural plan. The architectural plan should then appear as an underlay
to the floor plan.

Lay out Zones

Lay out example zones to verify appearance.

From the Zones tab of the Object Browser in Planner:

1. Place an internal area zone Internal Area to delineate the maximum retail area.
2. Place Department type zones.

3. If other zone types have been created (for example sub-departments), place some
of those.

Note: A floor plan requires zones of type Department before it can
be opened in ISSC.

Lay out Fixturing

The temporary floor plan does not require fixturing to the same standard as a real life
floor plan. However, the floor planner should lay out arrays of fixtures and gondola
runs in a way as to suggest a regular store layout.

= Placing fixtures can be accomplished from the Blocks sub tab of the Object
Browser.

= Placing gondolas can be accomplished from the Gondolas sub tab of the Object
Browser.

Draw Aisles

Aisles serve several purposes in MSM:
s They indicate the position of real aisles in a physical store.

s The direction in which they are drawn can be used to identify the main traffic
direction in the aisle. This in turn can be used to determine whether planograms
are placed in normal or reversed orientation.

s The Aisle Adjacency calculation associates fixtures with aisles. This information
can then be used for reporting purposes.

A number of aisles can then be drawn between parallel gondolas runs to verify they
place correctly.

Place Products

The product hierarchy and its associated products were imported at an earlier stage.
Place products at different levels from the product hierarchy ranging from department
level to SKU. These will later be used to check text styles, adjacency calculations and
SO on.

Place Planogram

The planogram hierarchy and its associated planograms were imported at an earlier
stage. Place planograms on a range of fixtures. These will later be used to check text
styles, adjacency calculations and so on.
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Text Styles

Planner Configuration

The purpose of this stage of the implementation process is to configure aspects of
Planner functionality. Some are concerned with the appearance of the floor plan - for
example annotation and title blocks. Other actions are concerned with floor plan and
planogram publishing. in preparation for setting up batch processes.

s Overview

s Text Styles

= Title Blocks

= Floor Plan Publishing
= Planogram Reports

= Planogram Publishing

Five things require to be configured: Text Styles, Title Blocks, Floor Plan Publishing,
Planogram Reports and Planogram Publishing. This configuration can be done using
the temporary floor plan created in the earlier stage.

For details of where to find detailed information on the actions in this chapter, see
Appendix A, "Information Locations."

Text styles are used to annotate the floor plans in the Planner module in MSM and the
product text in Schematic Preview in ISSC. The Text styles are:

Table 8—1 Text Styles in use in MSM

Text Style Description

General This text style is not in use.

Dept User for zones of type Department.

Internal Used for zones of type Internal Area.

Zones Used for zones of type Other.

Product Used for annotating product placeholders.
Planogram Used for annotating planograms.

Profile Used for annotating planogram bays (profiles).
Bay Numbering Out of scope for this implementation.
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Table 8-1 (Cont.) Text Styles in use in MSM

Text Style Description

Fixture Used for annotating fixtures.

Table 8-2 Text Styles in use in ISSC and ISSC Mobile

Text Style Description

Product SKU Annotation for products in Front Graphical and Planogram
View.

Product Mobile SKU Annotation for products in ISSC Mobile.

Note: Only fixtures whose Include Fixture Annotation property is
checked in Fixture Studio will be annotated. This is set in the Category
tab of the Block Details dialog box in the Fixture Studio module.

Overview of Configuring Text Styles in MSM

This section discusses configuring text styles used to govern annotation in the MSM
Planner module. Configuring text styles in ISSC and ISSC mobile will be discussed in
the pertinent sections for those applications. Text styles are configured in the Text
Styles dialog box from the Planner menu in the Administration module. They can be
updated in the Planner module by opening a floor plan and using the Annotation
dialog box (accessed from the Modify Menu or the Retail Toolbar). The method of
working is as follows:

1. Update and save the text style in the Text Styles dialog box in the Administration
module.

2. Close and reopen planner.

3. Using the temporary floor plan in the Planner module, open the Annotation dialog
box. This can be accessed from the Retail toolbar.

4. Highlight the required style and click OK.
5. Repeat until the appearance of the text style matches the retailer’s requirements.

The initial settings generally involve position, text size, color and offset. The offsets are
normally chosen so that fixture, product, planogram and profile annotation do not
overwrite each other. Once signed off by the customer, no further configuration of text
styles is required.

Zone Annotation

There are three forms of zone annotation: for internal areas, department type zones
and ‘other’ type zones. During the initial implementation the main things that are
modified are the text size and color.

Fixture Annotation

Fixture annotation is used to label each fixture with its name. The initial settings
generally involve position, text size, color and offset. For fixture annotation to be
visible:

s The Include in Fixture Annotation check box must be checked in the Category
Tab of the Block Details dialog box in Fixture Studio.
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Note: For gondolas, annotation can be simplified by having only the
base fixtures annotate.

Fixture annotation must be manually added using the Annotation dialog box
accessed from the Retail toolbar in Planner. (Many other annotation styles are
added automatically when an object is placed).

Merchandise Annotation
There are three forms of annotation for merchandise:

Product Annotation - for when products placeholders are individually placed on a
fixture.

Planogram annotation - for when planograms are placed on fixtures.

Profile annotation - used for showing the bay sequence for multi-bay planograms.

Practical Configuration of Text Styles

The configuration method set out below allows basic configuration of text styles.
Parameters not specifically detailed for configuration should be left untouched.

Note: More detailed configuration is possible - see the
Administration module help file for more details.

Text Style Dialog Box
Set the following for each text style:

Set the Color and Dimension Color to an appropriate value.

Ensure the Use Separate Text checkbox is not selected. This will ensure (for
example) that runs of fixtures are only annotated once - and not on every fixture.
(The exception to this is profile text - this appears once per bay for a planogram).

Text Style Rules Dialog Box

This is accessed from the Text Style dialog box by double clicking a rule. Set the
following:

Set the Field Index. This is the field selected from the SQL in the Query tab of the
Text Styles dialog box. The Field Index ignores the first two fields as these are
required by the functionality to identify the parent object in the floor plan.

Ensure the Scale and Scale Offset checkboxes are not checked. This will ensure
the annotation remains a single fixed size irrespective of any scale that might be
applied to the floor plan. It also makes configuration easier.

Ensure the Fit Within checkbox is selected. In combination with deselecting the
Use Separate Text checkbox this will keep the annotation within the bounds of the
run of fixtures containing the object.

Select the most appropriate option from the Abbreviate, Truncate or Word Wrap
options to cater for the case that the text is too long for the parent fixture. Word
Wrap is often the most effective option to select.

Set the Size to an appropriate value. This determines the size of the text.
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Title Blocks

= Set the Offset to a suitable value. This determines the placement relative to the
parent fixture. This offset (together with the justification and position) should be
different to those for other text styles.

Suggested Settings

Some suggested settings for text style rules are:

Table 8-3 MSM Text Styles

Text Style Size X Offset Y Offset Field Index
Internal Area Zone 20 0 0 1,2
Department Zone 15 0 0 1,2

Other Zone 10 0 0 1,2

Fixture 6 0 0 1

Product 6 0 -2 1

Profile 6 0 -9 1
Planogram 6 0 -16 3

Note: These setting may be combined with the Insertion and
Justification options if required.

The above recommendations are for an Imperial database. For a metric one, multiply
these values by 25.4.

Field Index

The Field index is selected from the Query tab of the Text Style dialog box. This
Custom SQL statement can be modified to allow alternative information to be
displayed. The Field Index - set in the Text Style rule dialog box - can be a list of
comma separated values identifying the position of the field in the query to be
displayed in the annotation.

Generally the first two values in the SQL Statement hold information allowing the
object to be annotated to be identified in the Planner floor plan. these values are
ignored by the code, so a field index of 1 typically refers to the third field in the SQL
statement.

Title blocks are used to frame the floor plan and to give information on it. The stages
for configuring a title block from scratch are:

1. Create an AutoCAD block in the Planner module.
2. Register the title block in Fixture Studio.

3. If required configure the Custom SQL to populate the information into the Title
block.

4. Define the Title Block and View Ports in the Administration module.

Default title blocks are provided with the application for printing or publishing those
floor plans. These are:
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s Imperial: ANSI D and ANSI E.
= Metric: A0 and Al.

These title blocks are installed in a local directory with each installation on MSM. Prior
to configuring them, a copy should have been placed on the file server in an
identically named directory to the local directory and the path to that directory
modified accordingly in the Directories tab of the Configuration Module.

Title Blocks can be populated with custom information in text boxes. This information
is read from the TITLEBLOCK_UPDATE Custom SQL in the AVITB_CUSTOM_SQL
table. The title blocks supplied with the application are already configured to read this
information.

1. When the Add Title Block command is used from the Insert Menu in the Planner
module for the first time, these text boxes will populate.

2. If the floor plan is modified, using the Update Title Block option from the Insert
Menu in the Planner module will refresh the information. For this to work, the
fields must contain AutocAD attribute definitions whose tag must match the pre
configured names provided or a field name in the Custom SQL.

If the default title blocks are used, only two additional steps are required to install the
title blocks. These are:

1. Reading the canonical media into the database.

2. Completing the configuration of the title blocks in the Administration module.

Reading in the Canonical Media

Before title blocks can be configured, details of the canonical media for the available
printers and plotters must be read into the database. This only be needs to be done
once and then the data will be available for all users of the MSP database. The steps to
do this are:

1. Download the Microsoft® Visual Basic® for Applications (VBA) module from the
Autodesk website. This add on enables scripts written in Visual Basic to be run
from within AutoCAD.

2. Create a macro to read the canonical media and save it. The required information
on this can be found on the AutoDesk website. The specific function name that has
to be invoked is GetCanonicalMediaNames().

3. Type VBARUN into the AutoCAD command line. This will bring up the Macros
dialog box. See the AutoCAD help files for how to load macros into this dialog box
and run them. Run the macro to import information into the AVITB_
TITLEBLOCK_CANMEDIA table. An example of visual basic to do this is given
below.

Example 8—1 Visual Basic to Read Canonical Media

Dim mvMediaNames as variant

Dim X as integer

mvMediaNames = Layout.GetCanonicalMediaNames ()

For X = LBound(mvMediaNames) To UBound (mvMediaNames)
print mvMediaNames (X)

Next

4. The information will then be available for configuring title blocks.
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Configuring in the Administration Module

These title blocks are provided in the MSM Block directory when MSM is installed.,
They are registered in Fixture Studio but require final configuration in the
Administration module. To do this:

Table 8-4 Adding the Title Block in the Administration Module

Step

Action

1

Open the Title Blocks dialog box from the Planning menu.

2

Click Add on the toolbar to enter details of the title block.

= Enter an appropriate descriptive name for the title block - for example A3 Title
Block.

= Select a Blockname from the drop down list. This will only show blocks with the
title block type assigned in Fixture Studio.

s Enter the Width of the title block. This is the total width of the title block
including the non-printable areas.

= Enter the Height of the title block. This is the total height of the title block
including the non-printable areas.

= Enter the Width Offset - this allows for the non-printable margin of the paper.
= Enter the Height Offset - this allows for the non-printable margin of the paper.

= Enter the Default Scale - this is the scale the floor plan will print at. Title blocks
are normally added in paperspace and printed at 1:1.

= Select the Canonical Media from the drop down list. This is the nominal paper
size and must match the designed size of the title block.

Select one of the values entered earlier and press Return to ensure the data is written
to the database.

Highlight the recently added entry and click Edit on the toolbar. This will bring up
the Title Block dialog box.

The Title Block dialog box is used to enter details of the viewports for the title block -
these are the areas of the title block through which the floor plan will be visible. click
Add on the toolbar to add details of the required viewports.

= Enter the Width of the viewport.
= Enter the Height of the viewport.

= Enter the Width Offset - this is the offset of the starting point of the viewport
from the lower left corner of the title block.

= Enter the Height Offset - this is the offset of the starting point of the viewport
from the lower left corner of the title block.

= Enter the Scale from the drop down list. This over-rides the general scale
assigned to the title block.

= Enter the View from the drop down list. This is the perspective the floor plan
will be viewed from.

Select one of the values entered earlier and press Return to ensure the data is written
to the database.

The Title Block will now be available to place from the Insert menu in the Planner

module.

Floor Plan Publishing

Floor plan publishing is used to publish floor plans to a designated directory. The
retailer then distributes those floor plans to the required recipients.
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Floor Plan Publishing is configured in the Administration module - although normally
run as a batch process, it can be manually run from the Planner module to test it. To
configure floor plan publishing open the Floor Plan Publishing Configuration dialog
box from the File menu in the Administration module. Make the following settings:

Table 8-5 Output Tab

Frame Description

Directory Structure Specify the directory (folder) structure that floor plans will be
published to. The retailer will then need to distribute the plans
within these folders to the pertinent destinations.

Format Specify the forms the floor plans will be published in. This will
generally be the electronic form most convenient to the retailer.
An example of a possible format is PDF.

General Specify the parameters that determine the time intervals used
for floor plan publishing.

Filename Structure Specify the form of the file name that will be generated when the
floor plan is published. The format of this filename can be
specified so as to include information that will assist its
identification and dissemination.

Table 8-6 Rendering Tab

Frame Description

Not named Specify the visual appearance of the floor plan and whether a
title block is required.

Table 8-7 Collation Tab

Frame Description
Single Frame Specifies the order electronic or hard copy versions of the floor
plan will be published.

Table 8-8 Pre-Processing Tab

Frame Description

Synchronize Specify how the Planner DWG file is to be synchronized against
the database and what objects are to be synchronized.

Restructure Drawing Specify what aspects of the floor plan are to be reset to the
defaults held in the database.

Annotation Specify the annotation that is to be updated before the floor plan
is published.

Calculations Specify the calculations that are to be refreshed before the floor
plan is published. This will ensure accurate reporting for the
published floor plan.

Table 8-9 Validation Tab

Frame Description
Single Frame Specifies the checks that will be carried out before the floor plan
will be published.
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The following settings can be used as a default if the retailer does not have more
specific requirements.

Table 8-10 Optional Default Settings for Floor Plan Publishing

Tab Settings

Output Tab = Create Store Subfolder option.
= Create PDF option.

s Include Store Code in filename structure

Rendering Tab Assume that the floor plan is in a suitable state for printing - no
rendering options will be required.
Collation Tab Collate by Store Code.
Pre-Processing = Autosynchronize option - select all items except shelves
and views.

= Annotation - select Products and Update Title block.

= Calculations - select Recalculate Fixture Adjacencies and
Recalculate Aisle Adjacencies

Validation Select Check for expired Planograms.

Once configured, the output can be tested by running Floor Plan Publishing manually
from the File Menu in Planner.

Planogram Reports

Planogram reports are configured in the Report Designer module. They are only
required if planogram design documents are not imported for disseminating via the
Planogram Publishing process. If MSP’s planogram reports are required because
planogram design documents are not being imported, they are created as below.

Note: Even if external planogram design reports are imported for
use in the Planogram Publishing process, it may still be useful to
configure a MSM Planogram report. This is because the planogram
publishing process has a setting allowing the MSM report to be used if
the imported report is missing.

Setting up the System Variables

Two system variables require setting for the Report designer module. This is done in
the System Variables dialog box accessed from the General Menu of the
Administration module. The system variables are:

RPTDSG_TESTPOGID

This system variable holds the POG_ID from the AVITB_PLANO table that identifies
a planogram design that can be used for test purposes while configuring the report.

RPTDSG_IMAGE_BASE

The RPTDSG _IMAGE_BASE System variable holds the identity of the mapped drive
or UNC path to a directory where any images associated with the report are held.
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Setting up the Report

Setting up the report is done as follows:

1.
2.

N o g e

Open the Report Designer module.

Select New from the File menu or toolbar. This will bring up the Report Properties
dialog box.

Enter the name of the report, units and other required properties. Click OK.
Configure the new report as required with tables, views and so on.

Save the report.

Close and reopen the report. If should show data from the test planogram

Print the report to verify it prints correctly.

Planogram Publishing

Planogram publishing is used to publish planograms to a designated directory. The
retailer then distributes those planograms to the required recipients. There are two
basic options for the directory structure:

Publish by Store: This option makes it easier for store managers as every
planogram for the store is in a specific directory. However, this may result in each
planogram being published multiple times.

Publish by Planogram Hierarchy: Each planogram publishes to a directory
mapped to a node in the planogram hierarchy. Each planogram is only published
once, but collating a set of planograms for a specific store is more difficult.

Planogram Publishing is configured in the Administration module - it can then be
manually run from the Planner module to test it. To configure planogram publishing
open the Planogram Publishing Configuration dialog box from the File menu in the
Administration module. Make the following settings:

Table 8-11 Output Tab

Frame Description
Format Specify the form in which planogram reports are to be output.
Directory Structure Specify the directory (folder) structure that planogram designs

will be published to. The retailer will then need to distribute the
planogram designs within these folders to the pertinent
destinations.

General Specify the parameters that determine the time intervals used

for floor plan publishing.

Filename Structure Specify the form of the file name that will be generated when the

planogram design is published. The format of this filename can
be specified so as to include information that will assist its
identification and dissemination.

Table 8-12 Templates Tab

Frame Description

All options are contained in  Specify the form in which planogram reports are to be output in.
a single frame. If the associated document option is chosen, this document must

have been imported with the planogram definition.
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Table 8-13 Collation Tab

Frame Description

All options are contained in  Specifies the order electronic or hard copy versions of the floor
a single frame plan will be published.

Table 8-14 Validation Tab

Frame Description

All options are contained in ~ Specifies the checks that will be carried out before the
a single frame planogram design is published.

The following settings can be used as a default if the retailer does not have more
specific requirements.

Table 8-15 Suggested Options for Planogram Publishing

Tab Settings
Output = Format - PDF File.
s Organize by Planogram Hierarchy
= Dept.
»s  C(lass.

s Sub-class.

= General - Re-publish planograms if files are missing option.

= Filename Structure - Include Planogram Name.

Templates Use planograms preferred template, if defined.
Collation Sort Order - Department.
Validation Assume that planograms were validated as imported - no

validation required.
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Batch Processes

This section describes the required batch processes.
s Introduction
= Batch Process Sequence

= Batch Process Descriptions

Introduction

This chapter describes setting up batch processes that require running on a regular
basis, for example daily, weekly or monthly. Batch processes are normally run
overnight to prevent impact on day-to-day performance.

Some of the tools discussed in this section may also be used for one off tasks during
implementation at a retailer, but this is outside the scope of this chapter.

For details of where to find detailed information on the actions in this chapter, see
Appendix A, "Information Locations."

Factors to take into Account

The following factors should be taken into account when setting up the batch
processes.

Batch Processes

The batch processes have to be run in a specific sequence to achieve specific tasks. This
sequence needs to be determined before the scheduling tool is configured.

Times used for Batch Processes

The time used for executing a batch process is based on the time on the database
server.

Scheduling Tool

Macro Space Planning does not contain a scheduling tool. The retailer will need access
to a suitable one.

Time Window

There will be specific time window to execute the batch processes. This is because
batch processes are processor intensive. Scheduling should configured so as not to
impair the activities of users carrying out normal manual tasks in the system.
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Batch Process User Group

In the Security chapters the creation of a Batch Process User Group and associated user
was suggested. The user name and password can then be used as a log in to run batch
processes. Having a dedicated user for this purpose prevents batch processes relying
on an administrator’s log in that may be expired if that person leaves the retailer.

From a security perspective, a set of log in credentials for MSP is exposed within any
associated batch files. Therefore this user should have the minimum privileges
required to run batch processes. It should not have wider credentials to - for example -
the Administration module.

Next IDs and the AVTTB_NEXTID Table

The database contains a table called AVITB_NEXTID. This contains the primary key
for the next entry in a number of tables. This table needs to be updated after each data
import via a batch process. There are several ways of doing this. These include:

= Manually from the Tools menu in the Administration module.
= By using the Post SQL option in Data Importer.
s By calling the AVISP_UPDATE_NEXT_ID stored procedure.

Failure to update the AVITB_NEXTID table can result in referential integrity problems
when the functionality is next used. SI's should select the most appropriate method for
each import.

Batch Process Sequence

A typical batch process sequence is as follows:

Table 9-1 Batch Process Sequence

Order Batch Process Description
1 Floor Plan Automated Used to ensure the Planner (AutoCAD) floor plan and
Processing the database contain the same information. As an

example, a prior batch operation may have altered
information in the database without the corresponding
information in the floor plan being updated.

2 Data Importer Import of all data except products at SKU 1 and display
Style level and planograms.

3 Planogram import Imports both products and SKU and Display Style level
and planograms

4 Adjacency calculations Updates aisle, fixture and product adjacencies.
Necessary for reporting and planogram substitution.

5 Planogram Substitution Swaps one planogram for another retail chain wide
according to pre-determined criteria.

6 Automated Calculations Updates calculations such as Product Adjacencies and
Space Measurements after POG substitution.

7 Publishing Publishing of floor Plans and planograms

8 Update Status Changes the status of floor plans and stores.
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Note: This sequence must be regarded as illustrative. Different
sequences of batch operations may be required to meet a specific
retailer’s requirement.s

Batch Process Descriptions

The batch processes are as follows:

Floor Plan Automated Processing

Floor Plan Automated Processing allows operations that ensure that the information
held in the Planner DWG file and the database is identical. A typical reason for this
would be a batch process changing data in the database that needs to be reflected in
the Planner DWG file. Floor Plan Automated Processing allows things like annotation
to be updated.

If the Auto Sync option has seen set to On (see the section on Synchronization in the
chapter on Initial Planner Setup), the floor plan will be automatically synchronised as
appropriate when the user opens the floor plan. Synchronizing via a batch process
avoids the wait to do that.

BatchRunner and the Command Line Switches

Batchrunner is a tool used to run some batch processes. It is a command line tool and
does not have an associated dialog box. By default it can be found in the C:\Oracle
Retail \AMSM\Common.Net folder. An example of the syntax is as follows:

BatchRunner /substitution username/password /t

Full details of this syntax can be found in the Macro Space Management
Administration Module User guide. Brief details are as follows:

Table 9-2 BatchRunner - Automated Floor Plan Processing Options

BatchRunner Option Description

/processplans Mandat'ory to identify the process as floor plan automated
processing

Username/Password Mandatory to access the database.

/t Terminates execution of any currently running substitutions. It

might be used to strop the batch process at the end of a time
window, even if there are tasks remaining to be executed.

/c Allows a comma separated list of store codes against which to
run the automated processing.

/s Allows a comma separated list of floor plan statuses codes
against which to run the automated processing.

/OUTOFSYNC Only process files where differences exist between the floor plan
and the database.

/THEME Causes the floor plans to be rendered with a specific layer
theme. Layer Themes are configured in the Layers and aliases
dialog box accessed from the Format menu in the Planner
module.

/VISUAL Causes the floor plan to be rendered with a specific AutoCAD
visual style.
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Table 9-2 (Cont.) BatchRunner - Automated Floor Plan Processing Options

BatchRunner Option Description
/TITLEBLOCK Causes a title block to be added.
/LAYOUT Causes a specific layout tab on the Planner DWG file to be used.
/SYNCn, m This option specifies the type of synchronization and the objects
to be synchronised. The n options are:
= 0=None

= 1= Auto-Synchronize

= 2 =Match Drawing

= 3 = Match Database

s 4 =Cross-Match

The m options are a bitwise integer. They are:
= 1 =Include Fixtures

» 2 =Include Shelves

s 4 =Include Products

s 8 =Include Other Blocks
s 16 = Include Zones

s 32 =Include Views

s 64 =Include Aisles

s 128 =Include Mark-Ups

/RESTRUCTURE n This option specifies which of the Restructure Drawing options
to use. These are bitwise options as follows:

= 1 =TRedefine blocks from disc

= 2 =Explode composite blocks

= 4 =Reset Level

= 8 =Reset color, line-type, lineweight to BYLAYER
= 16 = Reset Layer

/ANNOTATE n This option specifies which of the annotation options to use.
These are bitwise options as follows:

= 1= Annotate Fixtures

= 2= Annotate Products
= 4 = Annotate Zones

= 16 = Update Title Block

/CALCULATE n This option specifies which of the annotation options to use.
These are bitwise options as follow:

= 1 =_Calculate Areas

= 2 = Calculate Fixture Adjacencies
= 4 =Calculate Product Adjacencies
= 8 =Calculate Aisle Adjacencies

= 16 = Calculate Space Measures

s 32 = Calculate Face Planes

For full information on the options for these command line switches see the Oracle
Retail Macro Space Management Administration User Guide.
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Data Importer

Data Importer can be used for simple imports during the implementation process. It
comes with several pre configured imports.

Table 9-3 Pre-configured Data Importer Import Definitions

Import Description Command Line Switch
Stores Imports the store hierarchy and store STORES
information.

Product Hierarchy Imports the Product Hierarchy down to Item  CATEGORIES

level.
SKU Imports SKU level information. SKUS
Fixtures Imports fixture information. This must be FIXTURES
preceded by an import of the Fixture
Hierarchy
Fixture Hierarchy = Imports a pre-defined fixture hierarchy. FIXGROUP
Sales Imports POS information into the AVTTB_ SALES
EPOS table.

The syntax is:

AVT5DataImport /STORES /SKUS /SILENT

Where "Path\Datalmport" is the path to and name of the executable file and the
options following it are command line switches.

Command Line Switches
There are two options for command line switches:

Table 9-4 Data Importer - Command Line Switches

Command Line Switch Description

/Import Type This is a user assigned command line switch set up during the
configuration of an import in Data Importer. An example of a
pre-configured import provided in the template database is
STORES.

/Silent This switch disables any confirmatory dialog boxes.

Planogram Import using ODI

Planogram import occurs in two stages:
1. The creation of an XML file holding the planogram designs.
2. The import of that XML file into the Macro Space Planning database.

The first of these stages is an SI responsibility. The second stage is an Oracle Data
Integrator scenario that is provided pre-configured with MSM.

Note: For products to be imported correctly, the product hierarchy
must be up to date. This may require periodic imports for this
purpose. This can be done using the preconfigured import in the Data
Importer module.
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Importing the XML File

The full details of importing the XML file are covered in the Oracle ODI Planogram
Import User Guide, Volume 1. The two basic methods of running scheduled imports are
as follows;

Run to a Schedule using ODI Studio and an Agent

Planogram imports can be scheduled at specific times using the scheduling tools
within ODI studio and a local or standalone agent.

Run via the Command Line

Planogram imports can be run from the command line using a local or standalone
agent and a scheduling tool. Using the pre configured scenarios delivered with ODI,
the syntax is:

startcmd.bat OdiStartScen -SCEN_NAME= START_ODI_XML_IMPORT -SCEN_VERSION=001
-CONTEXT=GLOBAL -OverwriteFlag ='Yes

Adjacency Calculations

Adjacency Calculations are a subset of the options available in the Automated
Calculations dialog box. It is useful to run the Fixture Adjacency and Product
Adjacency calculations prior to planogram substitutions and so on. This is in case a
store planner has forgotten to do it after manually editing the floor plan.

By default, the executable is found in the C:\Oracle Retail \AMSM\Common folder.
The syntax to run it is:

AVT5AutomatedCalcs.exe /Silent /Options /Status /Files

Where "Path\AVT5AutomatedCalcs" is the path to and name of the executable file
and the options following it are command line switches.

Note: Automated Calculations has a dialog box. An alternative is to
run the commands manually.

Command Line Switches

A number of command line are provided. Parameters must be provided for the
/Options, /Status and /Files switches.

Table 9-5 Automated Calculation - Command Line Switches

Command Line Switch Description
/Silent This switch disables any confirmatory dialog boxes.
/Options This is a bitwise value specifying the selected options. The

options are:

= 0=No selection

= 1=Aisle Adjacency

» 2 =Allocated Area

s 4 -Face Planes

= 8 = Fixture Adjacencies

= 16 = Product Adjacencies

= 32 = Space Measurements
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Table 9-5 (Cont.) Automated Calculation - Command Line Switches

Command Line Switch Description

/Status This is a list of file statuses to process. It is in for form of a pipe
delimited list of Status Codes from the Status dialog box
accessed from the General Menu in the Administration module.
These status codes must be defined in the Status dialog box
before they are used in batch processes. An example would be
PRIISIAU.

/Files This is a list of files to process. It is a pipe separated list of FIL_
ID’s from the AVTTB_FILE table. An example would be
20130140.

Planogram Substitution

Planogram substitution is a method for automatically substituting one or more
planograms for new planograms in a floor plan. It can be done in multiple stores. The
process can be done manually. It is more usual for the required planogram
substitutions to be imported into the database and then run as a batch process. A
number of system variables affect the operation of planogram substitution.

Table 9-6 Planogram Substitution System Variables

System Variable

Description

PLANOGRAM_
SUBSTITUTION_RUN_CALCS

Determines whether product adjacency calculations are run
on a floor plan immediately prior to running a planogram
substitution. 0 = No, 1 = Yes.

PLANOGRAM_
SUBSTITUTION_PROCESS_
EXPLODED

Planograms can exist in one of three forms: 2D, 2.5 D or 3D.
this system variable determines which forms are processed.
The options are:

0 = Only substitute planograms in 2D form. Do not log
3D planograms that were not substituted.

1 = Only substitute planograms in 2D form. Log 3D
planograms that were not substituted.

2 = Substitute planograms in all forms with 2D
planograms.

3 = Substitute planograms in all forms with 2D
planograms and write information on the 2.5D and 3D
planograms substituted into the planogram substitution
log.

4 = Substitute all planograms, placing the replacement
planogram in the same form as the planogram that was
substituted.

PLANOGRAM_
SUBSTITUTION_LENGTH_
TOLERANCE

Sets the default tolerances for planogram length when
carrying out planogram substitutions. This value can be
overwritten when configuring specific planogram
substitutions.

PLANOGRAM_
SUBSTITUTION_HEIGHT _
TOLERANCE

Sets the default tolerances for planogram height when
carrying out planogram substitutions. This value can be
overwritten when configuring specific planogram
substitutions

PLANOGRAM_
SUBSTITUTION_HEIGHT _
TOLERANCE

Sets the default tolerances for planogram depth when
carrying out planogram substitutions. This value can be
overwritten when configuring specific planogram
substitutions
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Table 9-6 (Cont.) Planogram Substitution System Variables

System Variable Description

PLANOGRAM_ Determines if planogram substitutions can be carried out in

SUBSTITUTION_COPY_FILE floor plans of current status. If enabled, the substitutions will
not be made in the Current file, but in any floor plan at
Authorized status for that store. If a floor plan at Authorized
status does not exist, a copy of the Current floor plan will be
created and set to Authorised status. 0 = Off, 1 = On.

PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED System Variable

This system variable can be set to one of five values. The value selected will affect the
form of planogram that is substituted. Planograms that are placed in planner will be of
a 2D form - a placeholder. Planograms in the merchandiser module can adopt different
form including 2.5D (planogram with shelves and product placeholders on the
shelves) and 3D (planogram with full details).

Giving Access to the Planogram Substitution Functionality

Before the planogram substitution can be run either manually or via a batch process,
the user invoking the functionality must be a member of a User Group with access to
the Planogram Substitution command group in the Group Relationships tab of the
Functional Security dialog box accessed from the Security menu in the Administration
module.

Importing the Planogram Substitution Definitions

The planogram substitution definitions are held in four tables in the database. These
are:

s AVTTB_POG_SUB_DEF

=  AVTTB_POG_SUB_DEF_STATUS
= AVTTB_PG_SUB_DEF_STORE

= AVTTB_POG_SUB_DEF_ITEM

Full details of these tables can be found in the Oracle Retail Macro Space Planning Data
Model.

In order to import planogram substitution definitions, the SI must set up the
appropriate imports. This is done using an ETL tool such as Oracle Data Integrator
(OD]). alternatively, it can be done using MSMs Data Importer module.

BatchRunner and the Command Line Switches

Batchrunner is a tool used as an entry point for some batch processes. By default it can
be found in the C:\Oracle Retail \AMSM\Common.Net folder. The syntax is as
follows:

BatchRunner /substitution username/password [/t] [/p] [/e definition_name_1,
definition_name_2, .., definition_name_n] [/c code_1,code_2, ..,code_n] [/s id_1,
id_2, .., id_n]

Full details of this syntax can be found in the Oralce Retail Macro Space Management
Administration Module User Guide. Brief details are as follows:
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Table 9-7 Batchrunner - Planogram Substitution Options

BatchRunner Option Description

/Substitution Mandatory to identify the process as planogram substitution

User name/Password Mandatory to access the database.

/t Terminates execution of any currently running substitutions.

/p Pauses execution of any currently running substitutions.

/e Allows a comma separated list of planogram substitutions to be
executed.

/c Allows a comma separated list of store codes against which to

run the planogram substitutions to be defined.

/s This is a list of file statuses codes to process. It is in for form of a
pipe delimited list of Status Codes from the Status dialog box
accessed from the General Menu in the Administration module.
These status codes must be manually added to the Status dialog
box before they are used in batch processes. An example would
be PRIISIAU.

Automated Calculations

Automated calculation can be used to update the Aisle Adjacency, Allocated Areas,
Face Plane, Fixture Adjacency, Product Adjacency and Space Measurement
calculations. This is generally done to ensure reporting is accurate after changes have
been made to a floor plan. By default, it is found in the C:\Oracle

Retail \AMSM\Common folder. The syntax to run it is:

"Path\AVT5AutomatedCalcs.exe" /Silent /Options /Status /Files

Where "Path\AVT5AutomatedCalcs.exe" is the path to and name of the executable
file and the options following it are command line switches.

Note: Automated Calculations has a dialog box. an alternative is to
run the commands manually.

Command Line Switches
The command line switches are:

Table 9-8 Automated Calculation - Command Line Switches

Command Line Switch Description

/Silent This switch disables any confirmatory dialog boxes.

/Options This is a bitwise value specifying the selected options.

/Status This is a list of file statuses to process. It is in for form of a pipe

delineated list of Status Codes from the Status dialog box
accessed from the General Menu in the Administration module.
These status codes must be manually added to the Status dialog
box before they are used in batch processes. An example would
be PRIISIAU.

/Files This is a list of files to process. It is a comma separated list of
FIL_ID’s from the AVTTB_FILE table.
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Floor Plan Publishing

Floor Plan publishing allows the automated publishing of floor plans to a designated
directory. The configuration of floor plan publishing was covered in the chapter on
Planner configuration. This section discusses how to run floor plan publishing as a
batch process. This process will execute on all floor plans where the Publish Date has
been met or exceeded.

Batch Runner and Command Line Switches

Batchrunner is a tool used as an entry point for some batch processes. By default it can
be found in the C:\Oracle Retail \AMSM\Common.Net folder. The syntax is as
follows:

Path\BatchRunner /publishplans username/password /t
Path identifies the location where the Batchrunner.exe has been installed.
The command line switches are as follows:

Table 9-9 BatchRunner - Floor Plan Publishing Options

BatchRunner Option Description

/publishplans Mandatory to identify the process as floor plan publishing.
Username /Password Mandatory to access the database.

/t Terminates execution of floor plan publishing after publishing

the currently active floor plan.

Planogram Publishing

Planogram publishing allows the automated publishing of planogram designs to a
designated directory. The configuration of planogram publishing was covered in the
chapter on Planner configuration. This section discusses how to run planogram
publishing as a batch process. This process will execute on all planogram designs
where the Publish Date has been met or exceeded.

Batch Runner and Command Line Switches

Batchrunner is a tool used as an entry point for some batch processes. By default it can
be found in the C:\Oracle Retail \AMSM\Common.Net folder. The syntax is as
follows:

Path\BatchRunner /publishpogs username/password /t
Path identifies the location where the Batchrunner.exe has been installed.
The command line switches are as follows:

Table 9-10 BatchRunner - Floor Plan Publishing Options

BatchRunner Option Description

/publishpogs Mandatory to identify the process as planogram publishing.
Username/Password Mandatory to access the database.

/t Terminates execution of floor plan publishing after publishing

the currently active floor plan.
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Update Status

By default, Update Status is an executable found in the C:\Oracle
Retail \AMSM\Common folder. If invoked, it will change the status of files and stores.

The syntax to run it is:
\AVT5UpdateStatus.exe /Silent

Where "Path\AVT5AutomatedCalcs.exe" is the path to and name of the executable
file and the option following it is a command line switch.

File Statuses

»  Files of Published status will be changed to Current status if the Effective Date is
met or exceeded. Any pre-existing Current file will be changed to historical status.

Stores

= Any store of Proposed Status will be set to Open status if the Opening date is met
or exceeded.

= Any store of Open status will be set to Closed status if the Closing date is met of
exceeded. All child objects will also have their expiry date set.

Command Line Switch
The command line switch is:

Table 9-11 Update Status - Command Line Switch

Command Line Switch Description

/Silent This switch disables any confirmatory dialog boxes.
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ISSC Setup

This section describes the actions to implement ISSC.
»  ISSC Server Service

= Preparatory Configuration

= Setting up Statuses for the ISSC Workflow

= Save Dialog Boxes

= District Manager Option

= Configuration in MSM Administration Module

For details of where to find detailed information on the actions in this chapter, see
Appendix A, "Information Locations."

ISSC Server Service

Connection between the ISSC client and the MSP database is done via the ISSC Server
Service. This caches values on startup. If parameters are changed, for example system
variables, then the ISSC Server Service must be stopped and restarted in order to have
the changes take effect in ISSC.

Restarting the ISSC Server Service will disconnect all current users. These should be
notified accordingly before the restart.

Note: Ensure the Web Services options are also turned on in the
ISCC Server Service configuration file.

Preparatory Configuration

Before stating to implement in ISSC, the appropriate user groups and users should
have been create. The SI doing the configuration should have access to a suitable
subset of stores, floor plans and products. The floor plan should also have at least one
zone of type Department in order for the floor plan to open.

Setting up Statuses for the ISSC Workflow

Implementing ISSC will mean the creation of additional statuses if the Submit, Accept
and Reject buttons are to be used in the Save dialog boxes. Configuring these dialog
boxes is described in a later section of this chanter. Similarly, those additional statuses
will be required is the District Manager functionality is to be used. Configuring access
to the District Manager button is described in the earlier chapter on Security.
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Both of these options allow a business workflow to be used within ISSC. The status of
a floor plan can be advanced if it meets specified criteria and it can be sent back to an
earlier status if it does not.

Overview of Statuses

MSP comes with five pre-configured statuses. These are:

Table 10-1 Pre-configured Statuses

Status Description

Proposed Initial status of a floor plan - all new floor plans are set to this by
default.

Authorised Floor plan approved for going into service. Has Publish and

Effective dates assigned.

Published Floor plan that has been published as preparation for being put
into service. Generally had status changed to this one by batch
process when Publish Date was met or exceeded.

Current floor plan that is in service. Generally had status changed to this
one by batch process when Effective Date was met or exceeded.

Historical Floor plan that has been superseded by a more recent one.

However, ISSC can be configured with three different forms of dialog box. These
enable an appropriately authorised user to save the floor plan or to change the floor
plan and simultaneously change the status (see next section for more details). For these
dialog boxes to be effective, additional statuses are required. If store planners and
managers are involved a typical business process in ISSC could be configured as
follows with some statuses visible to a user in ISSC and some not.

Table 10-2 Additional Statuses in ISSC

Status User Save Dialog box Description
ISSC ISSC Store Submit Status changes to ISSC Approval
Planner

ISSC Approval  ISSC Manager Accept/Reject Reject changes status back to ISSC.
Accept changes status to Authorised.

Authorised MSM N/A Status not visible in ISSC

This business process might work as follows:

1. MSM Planner creates basic floor plan and sets it to ISSC status. This makes it
visible in ISSC.

2. The ISSC store planner puts the finishing touches to the store. They click the
Submit button on his Save dialog box. This changes the status to ISSC approval.

3. The ISSC Manager has the Save dialog box with Accept and Reject options. Reject
will set the status back to ISSC for the ISSC Store Planner to make further changes.
Accept will set the status to Authorised when it will not longer be visible in ISSC.

Note: It is possible to set up many other business processes. this is a
simple example.
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Creating Additional Statuses

Each additional Status requires a corresponding Status Level. Statuses are added as
follows

1. Create the required status levels.

2. Create and configure the required statuses.

Creating a Status Level

To create a Status Level access the Status Level dialog box from the General menu in
the Administration module. In the dialog box, Click the Add icon on the toolbar. Type
in the description of the new status level, for example ISSC and Press Return to write
the data back to the database.

Creating a File status

To create a status access the Status dialog box from the General menu in the
Administration module. Edit the Order of the existing File statuses to allow for the
addition of the new status. This can be done by highlighting each value, editing it and
pressing Return. click the Add icon on the toolbar of the dialog box and Enter the
following information:

Table 10-3 File Status Options

Option Description

Type Set to File from the drop down list.

Level Set to the recently created Status Level.

Description Add an appropriate description.

Order Type in an appropriate value for the order so that the new status
takes it place in the required sequence.

Options Decide where the status should be Reversible, Read Only or
Selectable.

Accept This is the status the file will change to if the Submit or Accept

buttons are clicked in the Save dialog box. Type in the name of
an appropriate status.

Reject This is the status the file will change to if the Reject buttons are
clicked in the Save dialog box. Type in the name of an
appropriate status.

Approve Select this checkbox if this file status is to be visible when the
District Manager Button is clicked on the ISSC Store Selection
dialog box toolbar.

Code If data is to be imported using this status, enter a value. This will

then be used as a Lookup by (for example) the Data Importer
module. The status code is also used as a command line
parameter by BatchRunner when batch processes are run.

After entering the pertinent information press Return to write the information back to
the database.

Note: For more information on the Accept and Reject options, see the
section on the Save dialog box. For more information on the Approve
option see the section on the District Manager option
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Save Dialog Boxes

There are three Save dialog boxes available for ISSC. These will appear when the floor
plan is closed with unsaved changes. These Save dialog boxes can be assigned to
specific User Groups so that different user groups have different privileges. These
dialog boxes are: identified by the PFO_ID field in the AVITB_PROCESS_FLOW_
OPTION table in the database. The dialog boxes are:

Table 10-4 ISSC Save Dialog Boxes

Dialog Box PFO ID Option

Save/Cancel PFO_ID =1 This option will save changes to the ISSC floor
plan but not change the status.

Save/Submit/Cancel PFO_ID =2 This option will save changes to the floor plan.
The Submit option allows the present status of
the floor plan to be changed to the one
specified in the Accept column of the Status
dialog box.

Save/Accept/Reject/Cancel PFO_ID =3 This option will save changes to the floor plan.
The Reject option allows the present status of
the floor plan to be changed o the one
specified in the Reject column of the Status
dialog box. The Accept option allows the
present status of the floor plan to be changed
to the one specified in the Accept column of
the Status dialog box.

A minimum of one extra floor plan status is required for the dialog box options that
allow ISSC users to change status. Configuration of these dialog boxes has to be done
directly in the database in the AVITB_PROCESS_FLOW table. This is configured
directly in the database as follows:

Table 10-5 Settings in AVTTB_PROCESS_FLOW table

Field Setting

MSEF_ID Set to 3: this is a foreign key to the AVITB_MESSAGE_FORM table.

PFL_ID Set to 1.

STA_ID Set to an appropriate STA_ID for a file status from the ABTTB_STATUS table.
This determines the status floor plan will be at when the required Save dialog is
shown.

USG_ID Set to the USG_ID from the AVITB_USER_GROUP table. This determines the
user group the Save dialog box will be associated with.

PFO_ID Set to 1, 2 or 3 depending on which Save dialog box is required. See the process
flow options in the table above. Different user groups would have different work
flows.

Once configured, clicking the Submit, Accept or Reject will result in the status of the
floor plan changing.

District Manager Option

The District Manager button provides an alternative to using the Accept and Reject
buttons on the Save dialog box. Access can be configured for specific user groups
allowing them to bulk approve or reject the floor plans they have responsibility for.

Three criteria have to be satisfied for the District Manager function to be active.
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Table 10-6 District Manager Rules

Rule Description

Functionality User Group The user must belong to a user group that has access configured
to the district manager button. See the chapter Security and
Creating Access for how to do this.

Correctly configured status  The floor plan status must have the approve checkbox selected
and Accept and Reject statuses specified.

Store and File Status User The user must belong to a a user group that has Data Security
Group access configured to a file status that has the Approve checkbox
selected and Accept and Reject statuses specified.

If all these criteria are satisfied, clicking the District Manager button in the Select Store
dialog box will bring up a list of all floor plans at the appropriate status. The user can
then use the Accept or Reject buttons on the toolbar to accept or reject those floor plans
one by one without the need to open them.

Configuration in MSM Administration Module

A number of ISSC parameters can be configured in the MSM Administration module.

System Variables

A number of system variables affect the default behavior of ISSC. Full details can be
found in the Oracle Retail Macro Space Management Administration Module User Guide.

General System Variables

Four general system variables need to be set. These affect the background behavior of
ISSC.

Table 10-7 General System Variables

System Variable Description

IN-STORE_TIMEOUT This is the length of time the server service will attempt to
communicate to the database before putting up an error
message. Set to 180 seconds by default.

IN-STORE_HELP_LOCATION  Help is supplied as a set of WebHelp files. These will
generally be installed in the file server so that updating the
help only has to be done once. This system variable holds
the path to the help.

MODULE_BLK_ID This system variable references the I_Module block supplied
with the default blocks. It is used for when products and
planograms are dragged to the floor in ISSC.

SKIP_ZONE_SELECT This system variable controls whether the zone selection
dialog box appears when a store is selected. By default it
appears, but it can be suppressed by setting the system
variable to 0.

System Variables for Merchandising
These system variables affect how merchandise behaves.
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Table 10-8 Merchandising System Variables

System Variable Description

IN_STORE_DEFAULT_POG_FILTERS This determines the initial settings in the
Planogram Filter dialog box. These settings
determine the default parameters that are checked
when a planogram is placed. By default it is set to
0 - no checks. The bitwise options are:

= 0:No Checks.

= 1: Match Fixture Length.

= 2: Match Fixture Height.

= 4: Match Fixture Style.

= 8: Match Temperature Range.

IN_STORE_PREVIEW_POG_REVISIONS Determines whether different planogram revisions
can be seen in Planogram Preview. By default it is
set to 1: On.

MERCH_MULTI_PROFILE This determines how merchandise populates. By
default it is set to 0 which does not allow multiple
products or planograms to be placed on a fixture.

System Variables for Annotation

These system variables control the appearance of the annotation for zones, fixtures,
products and planograms. Some modification of the default values will be required to
change the annotation to the appearance desired by the retailer.

Zones
There is a single system variable affecting zone annotation.

Table 10-9 System Variable for Zone Annotation

System Variable Description

TEXT_ZONE_TEXTSIZE Size of text for zone annotation.

Fixtures

There is two forms of annotation for fixtures; fixture annotation and bay numbering.
There are a series of system variables controlling fixture annotation. The more
important are:

Table 10-10 Main System Variables for Fixture Annotation

System Variable Description

TEXT_FIXTURE_TEXTSIZE Controls the size of the text for fixture annotation (and also
for bay numbering).
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Table 10-10 (Cont.) Main System Variables for Fixture Annotation

System Variable Description

TEXT_FIXTURE_OPTIONS Bitwise variable that controls the items of text that appear.
The options are:

s 1 =Turn Fixture Text on.

= 2 =Scale Size - not currently enabled.

= 4 =Scale Offset - not currently enabled

= 8 =Reduce Text Size to Fit - not currently enabled.

= 16 = Reduce Text width to Fit - not currently enabled.

= 32 = Change Text to Multiline Fit - not currently
enabled.

= 64 = Narrow Fixture Check - not currently enabled.
= 128 = Display Major Units - not currently enabled.
= 256 - Not currently in use.

s 512 = Include Block Name.

= 1024 = Include Block Description.

= 2048 = Include Block Length.

= 4096 = Include Block Depth.

s 8192 = Include Block Height.

= 16384 = Separate. Used for Gondolas. If selected
annotation will appear once per fixture. If not
annotation will appear once per gondola.

TEXT_FIXTURE_INSERTION These two system variables control the general position of

TEXT_FIXTURE_JUSTIFICATION the fixture annotation.

TEXT_FIXTURE_X_OFFSET These two system variables can be used to fine tune the
TEXT FIXTURE Y OFFSET position of the annotation. In particular they can be used

- - - to ensure that the fixture annotation is not in the same
position as profile or product annotation.

There is a single system variable for bay numbering.

Table 10-11 System Variable for Bay Numbering.

System Variable Description

ISSC_BAY_ANNOTATION This controls the type of annotation in use: Depending on the
setting it can be either the same bay numbering applied in the
Planner module, the Fixture ID from the AVITB_FIXTURE table
of a value imported into the FIX_TAG field in the AVTTB_
FIXTURE table. The options are:

s 0=Use Bay Number Prefix and Bay Number from AVITB_
FIXTURE table.

s 1="UseFIX_TAG from AVTTB_FIXTURE table. this value
can only be populated by import.

s 2 =Use FIX_ID from the AVITB_FIXTURE table.

Profile

Profile annotation carries information on the individual bay within a planogram. The
most important system variables controlling it are:
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Table 10-12 Main System Variables for Profile Annotation

System Variable Description
TEXT_PROFILE_TEXTSIZE Controls the size of the text for profile annotation.
TEXT_PROFILE_OPTIONS Bitwise variable that controls the items of text that appear.

The options are:

1 = Turn Profile Text On.

2 = Scale Size - not currently enabled.

4 = Scale Offset - not currently enabled.

8 = Reduce Text Size to Fit - not currently enabled.

16 = Reduce Text Width to Fit - not currently enabled.

32 = Change Text to Multiline to Fit - not currently
enabled.

64 = Narrow Fixture Check - not currently enabled

128 = Include Planogram Number (POG_ID from the
AVTTB_PLANO table.

256= Separate. If selected, the planogram description
will appear on every bay:. If not selected the
planogram description will appear once per
planogram.

512= This option has no effect other than a 1
appearing in front of each bay.

1024 = Not used.
2048 = Not used.
4096 = Include assortment code.

8192 = Include Product count - this has no effect
except to put a single digit number in front of each
fixture.

16384 = Include Bay Sequence number.

TEXT_PROFILE_INSERTION These two system variables control the general position of

TEXT_PROFILE_JUSTIFICATION

the profile annotation.

TEXT_FIXTURE_X_OFFSET These two system variables can be used to fine tune the

TEXT_FIXTURE_Y_OFFSET

position of the annotation. In particular they can be used
to ensure that the profile annotation is not in the same

position as fixture or product annotation.

Product

Product information identifies the product or planogram on a fixture. The most
important system variables controlling it are:

Table 10-13 Main System Variables for Product Annotation

System Variable

Description

TEXT_PRODUCT_TEXTSIZE

Controls the size of the text for profile annotation.
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Table 10-13 (Cont.) Main System Variables for Product Annotation

System Variable Description

TEXT_PRODUCT_OPTIONS Bitwise variable that controls the items of text that
appear. The options are:

1 = Turn Product Text On.

2 = Scale Size - not currently enabled.

4 = Scale Offset - not currently enabled.

8 = Reduce Text Size to Fit - not currently enabled.

16 = Reduce Text Width to Fit - not currently
enabled.

32 = Change Text to Multiline to Fit - not currently
enabled.

64 = Narrow Fixture Check - not currently enabled.
128 = Major display units - not currently enabled.
256= Show flow direction - not currently enabled.

512= Show Planogram description. Not currently
enabled - planogram description will show
automatically.

1024 = Show Number of Bays. This option will be
preceded with an M.

2048 = Display total Length of Fixtures.
4096. Use Alternative Units. Not currently enabled.

TEXT_PRODUCT_INSERTION These two system variables control the general position

TEXT_PRODUCT_JUSTIFICATION

of the product annotation.

TEXT_PRODUCT_X_OFFSET These two system variables can be used to fine tune the

TEXT_PRODUCT_Y_OFFSET

position of the annotation. In particular they can be
used to ensure that the profile annotation is not in the

same position as fixture or profile annotation.

System Variables for Mark-ups and Notes

Markups are freehand lines and clouds that can be drawn in a floor plan to call
attention to specific areas. Notes can be placed on specific features in a floor plan to

add a short text comment.

Markups

There are two system variables for markups.

Table 10-14 System Variables for Mark-ups

System Variable

Description

IN-STORE_MARKUP_LINEWIDTHMIN

Controls the line width drawn when the left
mouse button is held down.

IN-STORE_MARKUP_LINEWIDTHMAX

Controls the line width drawn when the right
mouse button is held down.

REVISION_CLOUD_ARC_DISTANCE

Specifies the length of arc used when a revision
cloud is drawn.

Notes

There are two system variables for Notes.
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Table 10-15 System Variables for Notes

System Variable Description
NOTE_FONT The font used for the notes.
NOTE_FONT_SIZE The size of the font used for the notes.

System Variables for Dimensions

Dimensions can be used to illustrate the width of aisles, lengths off fixtures and so on.
There are three system variables for annotation.

Table 10-16 System Variables for Dimensions

System Variable Description

IN-STORE_MARKUP_TEXT_FACE The font used for both dimensions and markups.

IN-STORE_MARKUP_TEXT_SIZE The size of the font used for both dimensions and
markups.

IN-STORE_DIMENSION_STYLE Specifies which of the three possible type of arrows
used for the dimensions is to be used. These are:

s 0 =No ticks or arrows
s 1=ticks

» 2=Arrow heads

Duplicating Floor Plans

ISSC has the facility to duplicate floor plans. A system variable determines what status
the copy of the floor plan will be set to.

Table 10-17 System Variable for Copied Floor Plan Status

System Variable Description

DUPLICATE_FLOOR_PLAN_STATUS_LEVEL References a STA_ID in the AVTTB_STATUS
table. Must be a file status.
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Overview

ISSC Mobile Setup

This section covers the configuration of ISSC Mobile.
s Overview

s ISSC Server Service

s Users and User Groups

»  MSM Administration

ISSC Mobile is an extension of ISSC. It allows a store associate to see changes in
equipment and merchandise. It also allows store associates to communicate
information via the medium of notes.

For details of where to find detailed information on the actions in this chapter,
Appendix A, "Information Locations."

ISSC Server Service

Connection between the ISSC Mobile client and the MSP database is done via the ISSC
Server Service. This caches values on startup. If parameters are changed, for example
the Custom SQL controlling annotation, then the ISSC Server Service must be stopped
and restarted in order to have the changes take effect in ISSC.

Restarting the ISSC Server Service will disconnect all current users. These should be
notified accordingly before the restart.

Users and User Groups

The detailed configuration of Users and User Groups is covered in the chapter on
Setting Up ISSC. The main criteria are as follows:

= A User Group can only access one store. That store must have a single floor and
that floor must be at current status. The User Group must also have Read
permissions to the store and floor status.

s The User Group must be assigned to the ISSC Mobile Command Group in the
Functional Security dialog box.

= Each store associate must have their own log in. If two people try and use the
same user name the first person will be logged out as the second logs on.
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MSM Administration

Several settings affecting the operation of ISSC Mobile can be changed in the MSM
Administration module.

System Variables

Two system variables affect ISSC mobile. These are configured in the System Variables
dialog box accessed from the General menu.

Table 11-1 System Variables affecting ISSC Mobile

System Variable Description

MOBILE_USER_TIMEOUT This is the time in seconds that ISSC Mobile can
remain inactive before automatically logging the
user out. By default it is set to 1,200 seconds (20
minutes).

MOBILE_ABSOLUTE_USER_TIMEOUT The maximum time in seconds a user can remain
logged in and active without being automatically
logged out by the software. By default it is set to
43,200 seconds (12 hours).

Custom Queries (Optional)

The Custom Queries dialog box (accessed from the General menu) allows a SI to
modify what ISSC Mobile displays in the properties pane. These custom queries come
with defaults, but if it is necessary to modify them the method is described in the
section on Configuring Reporting.

Table 11-2 ISSC Mobile Custom Queries

Custom Query Description

ISSC Mobile File Properties  The general properties displayed for a floor plan.

ISSC Mobile Fixel Properties The properties displayed for an item of planogram equipment.

ISSC Mobile Fixture The properties displayed for an item of equipment.

Properties

ISSC Mobile POG Product =~ The properties displayed for a product in a planogram.
Properties

ISSC Mobile Profile The properties displayed for a profile (bay) in a planogram.
Properties

ISSC Mobile Profile Continuation of the SQL for the displayed for a profile (bay) in a
Properties 2 planogram.

ISSC Mobile Zone The properties displayed for a zone.

Properties
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Introduction

Custom SQL

Configuring Reporting

This section describes how to configure the reporting methods used in Macro Space
Planning. Reporting can be used for a variety of purposes including assisting with
store planning, validating floor plans after they have been designed and reporting on
performance.

s Introduction

s Custom Queries

= Quick Reports

s KPIs (Key Performance Indicators)

= External Reporting Tools

There are four basic forms of reporting.
s Custom Queries

= Quick Reports

= KPIs

= External Reports

MSP comes with pre-configured Custom Queries, Quick Reports and KPIs. These can
be used unmodified. Alternatively, retailer specific ones can be configured.

External reports are not included in the MSP package. Instead, an external reporting
tools - for example Oracle's BI Publisher - has to be configured to generate reports
from the database.

For details of where to find detailed information on the actions in this chapter,
Appendix A, "Information Locations."

Custom Queries and Quick Reports use Custom SQL. The SQL statements using this
are stored in the AVITB_CUSTOM_SQL table. Custom SQL is an extension of
standard SQL. It allows the use for placeholders (denoted by the use of curly brackets).
The functionality will substitute the pertinent value of the placeholder when it
executes the SQL statement. A simple example would be as follows:

Select * from AVTTB_STORE where STR_ID = {STR_ID}
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Custom Queries

When the statement is executed, the code will substitute the STR_ID for the currently
active floor plan. The statement that will execute will thus be:

Select * from AVTTB_STORE where STR_ID = 123

This means implementers and administrators can write generic SQL statements that
will execute against the currently active object in the application.

The best way to develop a Custom SQL statement is to write it in standard SQL with
real values for what will be the placeholders. For example a real STR_ID could be used
in a Where clause. When the query executes satisfactorily, then a placeholder - for
example {STR_ID} - can be substituted as required.

Note: Custom SQL cannot be used in external reporting tools.

Custom Queries

MSP comes with pre-configured Custom Queries. This section describes the Custom
Queries pertinent for Macro Space Management. They come configured with a default
query that will meet most retailer’s requirements. If the retailer has more specialised
requirements, the Custom Queries can be modified.

Note: A list of MSM Custom Queries and ISSC Mobile Custom
Queries is provided below.

MSM Custom Queries

The MSM Custom Queries are as follows:

Table 12-1 MSM Custom Queries

Custom Query Description

Fixture Swap Controls the selection of fixtures for the Fixture Swap
functionality in Planner.

Floor Plan Print Controls the selection of floor plans for floor plan printing.

Floor Plan Publish Controls the selection of floor plans for floor plan publishing

Planogram Substitution Selection of planograms for substitution definitions in the

Definitions Planogram Substitution dialog box.

Planograms This used in the Planogram Substitution dialog box to populate
the list of planograms.

POG Print Controls the selection of planogram for the Planogram Print
dialog box.

Publish POG By POG Controls the selection of planograms for planogram publishing

Hierarchy where publishing is to be by planogram hierarchy.

Publish POG by Store Controls the selection of planograms for planogram publishing

Hierarchy where publishing is to be by store hierarchy.

Stores This used in the Planogram Substitution dialog box to populate

the list of stores.

ISSC Mobile Custom Queries
The ISSC Mobile Custom Queries are as follows:
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Quick Reports

Table 12-2 ISSC Mobile Custom Queries

Custom Query Description

ISSC Mobile File Properties  The general properties displayed for a floor plan.

ISSC Mobile Fixel Properties The properties displayed for an item of planogram equipment.

ISSC Mobile Fixture The properties displayed for an item of equipment.

Properties

ISSC Mobile POG Product ~ The properties displayed for a product in a planogram.
Properties

ISSC Mobile Profile The properties displayed for a profile (bay) in a planogram.
Properties

ISSC Mobile Profile Continuation of the SQL for the displayed for a profile (bay) in a
Properties 2 planogram.

ISSC Mobile Zone The properties displayed for a zone.

Properties

Configuring the Custom Queries

Note: custom Queries can use Custom SQL placeholders - see section
on Custom SQL at the beginning of this chapter.

Custom Queries are configured in the Custom Search Query dialog box accessed from
the General menu in the Administration module. Each query can be selected from the
drop down list at the top of the dialog box. Selecting a specific query will bring up text
documenting the requirements for that piece of custom SQL. The Custom SQL
statement can then be modified as required. The test button allows the custom SQL
statement to be verified before it is saved

Quick Reports

Quick Reports allow a floor planner to get listed information on the currently active
floor plan. They are accessed from the Reports option on the view menu in Planner.
The application comes with a set of pre configured reports that will meet the needs of
most retailers. Implementers have the option of deleting existing reports and adding
new ones.

Note: Quick Reports can use Custom SQL placeholders - see section
at beginning of this chapter. The application comes with a number of
generic Quick Reports - the available placeholders can be determined
by inspecting the Custom SQL for these reports.

Configuring Quick Reports

Quick Reports are configured directly in the database. This is done in the AVTTB_
CUSTOM_SQL table. Quick Reports ban be of three general types. The type is defined
by its CST_ID (AVITB_CUSTOM_SQL_TYPE table).
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Table 12-3 Quick Report Types

CST_ID Description

1 Store Plan Report.
2 Planogram Report.
3 General Report.

Deleting Custom Reports

To delete a custom report remove the pertinent row from the AVITB_CUSTOM_SQL
table.

Adding Custom Reports
To add a custom report, add a new row in the AVITB_CUSTOM_SQL table.

Table 12-4 Fields for AVTTB_CUSTOM SQL table

Column Description

CSQ_ID Primary key for the table.

CSQ Name Name of the Quick Report. This will appear in the Quick
Reports dialog box.

CSQ_FILTERFIELDNAME1 Not required.
CSQ_FILTERFIELDNAME?2 Not required.

CSQ_SQL The Custom SQL that will execute.when the Quick Report is
opened or refreshed.
CST_ID. Foreign key to the AVITB_CUSTOM_SQL_TYPE table.

Identifies the use for the Custom SQL.

KPIs (Key Performance Indicators)

KPIs allow a floor planner to get visual information on the currently active floor plan.
They are accessed from the KPI tab of the Object Browser. The application comes with
a set of pre configured KPIs that will meet the needs of most retailers. Implementers
have the option of deleting existing KPIs and adding new ones.

Overview of Configuring KPIs

KPIs are configured in the Administration module. There are two basic components to
the KPI:

= Color Theme - this specifies the colors objects will be color coded.
= KPI - this specifies the data for the KPL.

Each KPI value should fall within a band within the associated color theme, causing
the specified objects to color accordingly. The KPI values themselves are supplied from
one of two sources:

s A SQL Statement
s A Stored Procedure
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KPIs in the Planner Module

For KPIs to work in the Planner module, the objects that make up the block must have
their lineweight set to ByBlock before the block was created. If this is not done, the
blocks will not color.

In addition, if the visual style in Planner is set to wire frame, only the outline of the
block will color. this can make the color changes in the KP1I difficult to see. To make
them more visible change the visual style to Realistic or Conceptual (View menu >
Visual Styles).

SQL statements for KPlIs

The SQL statement for a KPI must contain five mandatory fields.

Table 12-5 Mandatory Fields for SQL Statements

Field Description

Object ID This is the identifier for the object that is to be colored by the KPI. The options
are:

= ZON_ID: primary key for zones from the AVITB_ZONE table.

s FIX_ID: primary key for fixtures from the AVITB_FIXTURE table.

= SHF_ID: primary key for shelves from the AVITB_SHELF table.

s PRO_ID: primary key for products from the AVITB_PRODUCT table.

Store ID The STR_ID is the identifier for the store which the KPI is being applied to. It is
from the AVTTB_STORE table (or as a foreign key in the AVTTB_FILE table).

Calendar ID  The CAL_ID is the identifier for the time period any data applies to. It is from
the AVITB_CALENDAR table. It can be for time periods such as weeks or
months for time sensitive data like sales results. For no time sensitive data it can
be se to the CAL_ID for All.

File ID The FIL_ID is the identifier for the floor plan that the KPI is to be applied to. It
is from the AVTTB_FILE table.

Result This is the actual value that will be used in the KPI. The selected objects will

Column color according to which band of the Color Theme falls within. Results should
be chosen such that they fall within a distinct band and not on a boundary
value.

Stored Procedures for KPls
The stored procedure used for KPIs must contain specified inputs and outputs.

Table 12-6 Mandatory inputs to Stored Procedure

Input Parameter Description

fileld IN NUMBER This is the FIL_ID (AVTTB_FILE table). It will be supplied by the
code when the stored procedure is executed.

calld IN NUMBER This is the CAL_ID (AVITB_CALENDAR table). It will be
supplied by the code when the stored procedure is executed.

storeld IN NUMBER  This is the STR_ID (AVTTB_STORE table). It will be supplied by
the code when the stored procedure is executed.

The stored procedure for KPIs must return a record set called SYS_REFCURSOR. This
must contain the following five mandatory fields. Note that the permissible options for
the Object ID vary depending on whether the KPI is for MSM and ISSC or for ISSC
Mobile.
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Table 12-7 Mandatory Fields for Stored Procedure Output

Field Description

Object IDs in  This is the identifier for the object that is to be colored by the KPI. For MSM and
MSM and ISSC the options are:

155C = ZON_ID: primary key for zones from the AVITB_ZONE table.
s FIX_ID: primary key for fixtures from the AVITB_FIXTURE table.
= SHF_ID: primary key for shelves from the AVITB_SHELF table.
s PRO_ID: primary key for products from the AVITB_PRODUCT table.

The record set should contain one - and only one - of these identifiers.

Object IDs in  This is the identifier for the object that is to be colored by the KPI. For ISSC
ISSC Mobile Mobile the options are:

= FIX_ID: primary key for fixtures from the AVITB_FIXTURE table.

= PPR_ID: primary key for the planogram products in the AVITB_POG_
PRODUCT table.

s EXL_ID: primary key for an item of planogram equipment in the AVITB_
POG_FIXEL table.

The record set should contain one - and only one - of these identifiers. The
identifier must be appropriate to the type of KPI.

Store ID The STR_ID is the identifier for the store which the KPI is being applied to. It is
from the AVTTB_STORE table.

Calendar ID  The CAL_ID is the identifier for the time period any data applies to. It is from
the AVITB_CALENDAR table. It can be for time periods such as weeks or
months for time sensitive data like sales results. For no time sensitive data it can
be se to the CAL_ID for All.

File ID The FIL_ID is the identifier for the floor plan that the KPI is to be applied to. It
is from the AVTTB_FILE table.

Result This is the actual value that will be used in the KPI. The selected objects will

Column color according to which band of the Color Theme falls within. Results should
be chosen such that they fall within a distinct band and not on a boundary
value.

A stored procedure can have multiple result columns, with different KPIs
referencing different columns. However, a KPI itself can only reference a single
column in its definition.

Deleting KPIs

To delete a KPI, open the Key Performance Indicators dialog box from the General
Menu in the Administration module. Highlight the required KPI in the list of KPIs and
click Delete. The KPI will be deleted.

Creating KPIs

To create a KPI, open the Key Performance Indicators dialog box from the General
Menu in the Administration module.

1. Create the required SQL statement or stored procedure that will be the source of
the data. Depending on the access granted to the database, this could either be
done by an SI or the DBA.

2. Create (or identify) a suitable Color Theme.
3. Create the KPI.
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External Reporting Tools

External Reporting Tools

External reporting tools can be used for many purposes. An example would be to
report on the quantities of merchandise required to put a new floor plan into service.
There are many Reporting Tools available - Oracle’s is BI Publisher.

Configuring the reporting tool is beyond the scope of this Implementation Guide -
please see the pertinent documentation.

External Reports and Logging

One use of external reports is to report from the log tables in the database. The tables
specified below typically hold the results of objects affected by batch processes.

Table 12-8 Tables used for logging batch operations

Table Description

AVTTB_FILE_PROCESS_LOG Holds information on all files that have been checked out
as part of a batch process. Batch processes include
Automated Calculations, Update Status.exe, Data
Importer, Planogram Substitutions and Planogram

Changes.

AVTTB_IMPORT_LOG Holds the results of Imports using the Data Importer
module.

AVTTB_POG_SUB_LOG Holds the results of any planogram substitutions or dry
runs that have been executed.

AVTTB_PROCESSLOG Holds the result of any files that have has their status

changes as a result of UpdateStatus.exe being invoked.

AVTTB_PROCESS_FILE_LOG Holds information on floor plans (drawings) subjected to a
batch process.

AVTTB_PUBLISH_POG_LOG Holds the results from Planogram Publishing.

In addition, there are other tables that log user actions. Examples include:

Table 12-9 Tables used for logging user actions

Table Description

AVTTB_FILELOG Holds details of files have been checked out by specific
users using the Store Manager module.

AVTTB_PLANO_LOG Hold details of which planograms have been edited by
users in the Merchandiser module.

AVTTB_SECURITY_LOG Hold details of users making changes to the Security
Options in the Administration module.

AVTTB_USER_LOG Holds details of all users that have logged into Macro
Space Management.

The SI should set up the reports required by the retailer. They may also wish to set up
a mechanism for purging data that is no longer required.
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Follow Up Actions

This section describes some of the follow up actions required by the retailer. These are
required to take the application after the initial implementation and put it into a
condition where the store planning process can be put into production. These actions
are summarized below but should not be regarded as an exhaustive list.

For details of where to find detailed information on the actions in this chapter,
Appendix A, "Information Locations."

= Macro Space Management
= In-Store Space Collaboration
= General Database Maintenance Actions

s Integration into Other Retailer Systems

Macro Space Management

The implementation process described for Macro Space Planning describes how to get
the application into a condition where detailed information for store planning can be
entered. This section gives some examples of that information.

Administration Module

There are a several additional options that can be configured. Two of the most
common are User Defined Attributes and Adjacency Rules and Severity Types. These
are not pre-requisites for going into production, but can be useful to the retailer.

User Defined attributes

User Defined Attributes are customizable items of information that can be assigned to
files, fixtures, planograms, planogram equipment (fixels), planogram products,
planogram profiles (bays), products, stores and users. These are configured in the User
Defined Attribute dialog box accessed from the General menu in the Administration
module.

Individual values can then be assigned in the pertinent dialog boxes in the various
modules. Alternatively, the values can be populated by data import.

Adjacency Rules and Severity Types

Adjacency rules and severity types can get set up to allow product adjacencies to be
reported in on a floor plan - typically be means of a KPI. this allows the user to see that
products commonly brought together are in suitably close physical proximity.
Adjacency Rules and Severity Types are configured using the respective options from
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Macro Space Management

Fixture Studio

Planner

the Planning menu in the Administration module. A suitable KPI will also need to be
developed.

Additional configuration can be carried out in Fixture Studio. Again, these are not
pre-requisites for production, but can be useful to the retailer. This includes:

Fixture Library

During implementation a partial set of fixtures were registered in Fixture Studio.
These were sufficient to carry out a number of required implementation tasks. The
retailer will have to create and register the full fixture library. If it is desired to use the
Merchandiser module, the corresponding 3DS files have to be created as well.

Gondolas

Similarly, a partial set of gondolas were created during implementation. The full set
must now be configured.

User Defined Attributes
Two forms of User Defined Attributes can be assigned to fixtures.

= Fixed Attributes: These are Definition Data assigned to all fixtures of a specific
type.

= Variable Attributes: These are Instance Data that can vary from fixture to fixture,
even for fixtures of the same type.

User Defined Attributes are custom information. They are configured in the
Administration module, assigned (as fixed attributes) to fixtures in Fixture Studio.
This lets retailers assigned their own very specific definition data to fixtures.

Variable attributes are instance data that can have specific values assigned in the
Planner and Merchandiser modules and in ISSC. An example of their use is verifying
compliance in a floor plan. Users in ISSC can walk round a WiFi enabled store and
assign them on a case by case basis to the pertinent fixtures.

Further configuration can be carried out by the retailer in the Planner module.

Store Manager

The full store hierarchy needs to be created in Store Manager. The store hierarchy was
imported down to store level. However, the floor plans now need to be created for
each store. This can be done in one of two ways:

s The entire floor plan can be created from scratch starting with an architectural
plan. this involves the placement of zones, equipment, aisles and merchandise.

= Ifaraw AutoCAD floor plan exists, and the requisite blocks have been registered
in Fixture Studio, importing the AutoCAD drawing into Store Manager, opening
the floor plan in Planner and then synchronizing ‘'match the drawing’. This will
write a lot of the information to the database.

Planner has functionality not present in AutoCAD. An example is the ability to
draw lines representing aisles and associated fixtures with them. This sort of
information will have to be manually added later in Planner.
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In-Store Space Collaboration

As an alternative to manual synchronisation, batch synchronisation of the recently
imported floor plans can be done using Floor Plan Publishing or Automated floor
Plan Processing.

Note: These floor plans can be validated in ISSC using the pertinent
functionality.

User Defined Attributes

If User Defined Attributes have been configured in the Administration module, they
can be manually assigned to stores, files and fixtures. Alternatively, these values can
be imported. Again, these are not pre-requisites for production but can be useful to the
retailer.

User Defined Attributes for planograms, planogram equipment, planogram products
and planogram bays are generally imported. These can be manually edited after
import or additional fields can be configured to hold additional information.

In-Store Space Collaboration

One of the potential uses for ISSC after an implementation process is to validate floor
plans.

Floor Plan Validation Tools

A number of tools for validation of floor plans are provided. These are:

Table 13-1 Validation Tools

Tool Description

User Defined Attributes Allows custom information to be assigned to objects in a floor
plan - for example fixtures.

Notes: Allows the floor plan to be annotated with comments.

Dimensions Allows a dimension to be measured in the floor plan and
compared to a physical dimension in the store.

Markups Allows objects in a floor plan to be highlighted to draw attention
to them.

Scan Schematic Allows an ISSC user to identify the planogram on a fixture in a

store. This is done by attacking a bar code scanner to a computer
running ISSC in a WiFi enabled store. The user can then go to a
physical fixture and start scanning bar codes. As more bar codes
are scanned, the functionality will progressively narrow down
the list of potential planograms.

= If the planogram show as present on the fixture is physically
present is can be left unchanged in the floor plan.

= If a different planogram is present on the fixture, the floor
plan can be changed accordingly.

= If no distinct planogram can be identified, a placeholder
planogram can be put in the floor plan pending resolution
of the problem.

Using Floor Plan Validation Tools

No hard and fast rules can be laid down for using these tools - the details will vary
from retailer to retailer. The general process is:
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1. Create a floor plan in Planner.
2. Set the floor plan to a status that makes it visible in ISSC.

3. Use an individual in the store to carry out a survey comparing the ISSC version of
the floor plan with the physical reality in the store.

4. Annotate the ISSC floor plan accordingly and change the status.

5. Use the information in the ISSC floor plan to update the floor plan in Planner,
ensuring that the floor plan reflects the reality in the store.

General Database Maintenance Actions

As a follow up to the implementing the process, the retailer may set up actions to run
as batch processes in order to maintain the optimum performance of the database.
Examples are given in the table below.

Table 13-2 General Maintenance Actions

Action Description

Periodically clear There are a number of tables with a suffix of _BAK in the database.

back-up tables. These are used to roll back data if a user closes a floor plan without
saving their latest changes. Over time these _BAK tables will gradually
fill up with data.

Files that have achieved Current or Historical status will no longer be
edited. Periodically purging the _BAK tables of data from files of this
status will keep the table size down.

Periodically clear Information is periodically written to log tables such as AVITB_EVENT
logs or AVTTB_FILELOG. Periodically purging older data from these tables
will keep the size down.

Update NEXT_ID The AVITB_NEXT_ID table holds the next primary key to be assigned

table for a number of database tables. If the value held in this table gets out of
sync with the actual value, referential integrity errors can result when
users use functionality.

After bulk import of data is carried out, this table should as a
precautionary measure after all imports have finished. One way of
doing this is to call the AVTSP_UPDATE_NEXT_IDS stored procedure.

Purging historical Floor plans that have been superseded by more recent versions are at

data historical status. The pertinent information is maintained in the
database until manually removed. There are two strategies for doing
this:

= Delete the data when the historical file reaches a certain age - for
example 15 months (five quarters) after it was superseded.

= Copy the data to an archive for preservation and delete the original
data.

Periodically purging data will keep the table size down.

Integration into Other Retailer Systems

MSP will need to be integrated into the retailers other systems. The detail of this is
outside of this implementation guide, but some examples are given below.

13-4 Oracle Retail Macro Space Planning Implementation Guide



Integration into Other Retailer Systems

Floor Plans and Planogram Designs

Floor plans and planogram designs will be published according to their publish dates.
They will generally be published in electronic form into folders at a specified location.
The users of this information will require access to the folder location.

Supply Chain

When a floor plan and its associated planogram designs are published, there will be a
need for new products and signage to be sent to the stores.Similarly, there may also be
a need for new equipment. This information needs to fed into the retailers supply
chain so that the required equipment, merchandise and signage arrives at the required
locations in a timely manner.

Distribution of Reports

It is possible to generate a series of reports that show how well space is being managed
- for example reports can show the sales per square foot of allocated floor area for a
fixture, planogram, sub department, department or store. Like floor plans and
planograms this information needs to be distributed in a timely manner to the
pertinent recipients.
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Validation Tasks

This section describes how to validate the implementation. The suggested checks
comprise a brief regression test to verify the main functionality is operating as
intended. After the completion of validation, the software should be in a position to be
handed over to the retailer for more detailed User Acceptance Testing (UAT).

Summary of Validation Testing
Initial Security

Basic Data Configuration
Data Import

Initial Fixture Studio Set Up
Initial Planner Set Up
Planner Configuration
Batch Processes
Configuring Reporting
ISSC Setup

ISSC Mobile Setup

Follow Up Actions

Summary of Validation Testing

This section contains all the suggested validation testing. Implementers may wish to
do this stage by stage as they complete each section of the implementation process.
Alternatively, they can be systematically executed after all stages of implementation
have been carried out.

For details of where to find detailed information on the actions in this chapter,
Appendix A, "Information Locations."

Initial Security

Initial security is concerned with setting up a sub-set of users who will be associated
with the rest of the implementation process.
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Basic Data Configuration

Table 14-1 Validation of Initial Security

Action Validation

Security Options Verify passwords can only be set according to the criteria
accounts are locked out as required and so on.

MSM User Accounts Verify that an example user from each user group can access the
pertinent MSM modules. Also verify that in Planner they can
assess the Find and Open, Search and Print and Automated
Processing dialog boxes.

ISSC User Accounts Verify example user groups can log in, have the toolbar

accessible and can access floor plans in the designated stores.
also verify that each User Group has access to the designated
Save dialog box.

If a User Group has access to the District Manager button verify
that it brings up a list of floor plans at the pertinent status.

Basic Data Configuration

Basic Data Configuration is usee to manually set up a number of parameters necessary
to allow further configuration.

Table 14-2 Validation of Basic Data Configuration - Configuration Module

Action Validation

Directories Verify that the directories are functioning as required. For
example create a temporary store, floor, revision and blank floor
plan in Planner and verify that the correct Windows folders are
created underneath the designated Store Root.

Files Verify that when a blank floor plan is created, the prototype

drawing can be accessed.

Table 14-3 Validation of Basic Data Configuration - Administration Module

Action

Validation

Calendar Data

Verify that Calendar data can be seen in the Calendar dialog box
(General Menu) contains a correctly configured calendar.

Zone Definitions

Verify the required zone definitions are present and that
example zones can be placed.
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Initial Fixture Studio Set Up

Data Import

This is the import of store, products, planograms and their associated hierarchies.

Table 14-4 Validation of Data Import

Action

Validation

Store
Hierarchy

After the store hierarchy and its associated stores have been imported confirm
that the total number of stores in the database matches the number to be
imported.

Take an example node in the store hierarchy and verify:
= All stores associated with that cluster are present.
= Basic store data (such as Open Date, Close Date and Status) are correct.

s Other information such as address information and UDAs is correct.

Product
Hierarchy

(In the Product
Studio
module)

After the product hierarchy and its associated products have been imported
confirm that the total number of SKU’s in the database matches the number to
be imported.

Take a node in the product hierarchy and verify:
All expected products are present at SKU level.

= The unique identifier used by the retailer to identify the SKU (SKU Code,
GTIN Number, and so on) is correct.

= The name and description of the products is correct.

= Ifrequired, the display style associated with the SKU is present and
correctly configured.

Planogram
Hierarchy

(In the
Merchandiser
module)

After the planogram hierarchy and its associated planograms have been
imported confirm that the total number of planograms in the database
matches the number to be imported.

Take a node in the planogram hierarchy and verify:
All expected planograms are present in the node.

= Basic data such as the Publish Date, effective Date, Expiry Date and
Status are correct.

ms  The planogram design if correct with the correct number of shelves and
with products in the correct sequence and with the correct quantity.

Note:

The varying logs should have been checked at the time of

import. The validation checks are independent confirmation the
import executed correctly.

Initial Fixture Studio Set Up

This is the configuration of a sub-set of the required fixtures and gondolas, together
with their associated hierarchies.
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Initial Planner Set Up

Table 14-5 Validation of Initial Fixture Studio Set Up

Action

Validation

Remapping System Blocks

Verify the following:
s I_PBASE_ : If this block is correctly mapped.

= I_Module: If this block is correctly mapped, products and
planograms can be dragged into an aisle in Top Graphical
view in ISSC.

= I REF_blocks: These blocks are used for bay numbering in
planner. Place an gondola and apply basic bay numbering.

= Title Blocks: After title block configuration has been
configured in the Administration module, open a floor plan,
place a title block and verify the published floor plan
contains the title block.

The above block names are for an imperial database. for a metric
database the equivalents are P_BASE__, MODULE and I_REF_.

Fixture Hierarchy

Verify fixture hierarchy has folders required by retailer.

Fixtures Place some of the example fixtures and confirm:
= Fixture goes onto designated layer and colors accordingly.
= Fixture merchandises with product block.
= Product block occupies specified merchandisable area. (The
merchandisable area should take into account the structure
of the fixture.
Gondolas Hierarchy Verify gondola hierarchy has nodes required by retailer.
Gondolas Place some example gondolas and verify:

= Gondola goes onto correct layer and places accordingly.
= All the correct combinations of sizes place.

= Example optional parts can be selected as required.

Initial Planner Set Up

The initial planner set up is concerned with configuring a number of system variables
and setting up a basic floor plan as preparation for further implementation tasks.

Table 14-6 Validation of Initial Planner Set Up

Action

Validation

System Variables

After the PUBLISH_DATE_LEAD_PERIOD and EFFECTIVE_
DATE_LEAD_PERIOD system variables have been set, take a
floor plan and set it to Authorized status in the File Properties
dialog box. Verify:

s The Publish Date is the specified number of data ahead of
today’s date.

= The Effective Date is the specified number of days ahead of
the Publish date.
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Planner Configuration

Table 14-6 (Cont.) Validation of Initial Planner Set Up

Action Validation

Synchronization How synchronization behaves can be tested by creating a floor
plan in Planner and then saving and closing it. The floor plan
can then be opened in ISSC, edited and saved. This will create a
difference between the data held in the Planner DWG file and
the database.

When the floor plan is re-opened in Planner, verify that
synchronisation is behaving as the settings made in the pertinent
system variables require. for example, if Auto-Synchronize is on,
does the floor plan automatically update with the modified
information in the database.

Creating the Store Verify that the correct structure of folders has been created
under the store root designated in the Directories Tab of the
Configuration module.

Architectural Plans Verify that architectural plans can be accessed. Associate an
architectural plan with a floor.

Zones Verify the following from the Zones tab of the Object Browser:

= Clashing: when zones of the same type are placed
overlapping, the Detect Clashes option on the toolbar
results in the overlapping zones being identified.

= Annotation: Verify the zones annotated when placed.

= Hatching: Verify hatching can be turned on and off.

Fixturing Place Fixtures and Gondolas. Verify that they go on the correct
layer and initially adopt the color of that layer.

Aisles Draw some test aisles and verify the aisles draw correctly with
annotation at the start.

(The reporting aspects for aisles will be checked in the reporting
section of validation).

Place products Verify products can be placed from different levels in the
product hierarchy.

Planograms Place some example planograms. Verify imported multi-bay
planograms can be placed in both normal and reversed
orientations.

Planner Configuration

Planner configuration is concerned with the setting up of annotation, the final
configuration of the provided title blocks and the configuration of floor plan and
planogram printing in advance of running them via a batch process.

Table 14-7 Validation of Planner Configuration

Action Validation

Text Styles Place several short gondolas. Merchandise those gondolas with
example products and planograms. Verify the fixture, product,
profile and planogram annotation are the correct size and do not
overlap when present simultaneously.
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Batch Processes

Table 14-7 (Cont.) Validation of Planner Configuration

Action

Validation

Title Blocks

Create a temporary floor plan with zones of specified area,
specified number of fixtures and so on. Insert a title block into
the floor plan.

= Verify that the information in the title block populates
correctly.

= Verify that the title block shows correctly when the floor
plan is manually published.

Floor Plan Publishing

Create a few temporary floor plans in Planner. Modify the floor
plan in ISSC so there is a difference between the data held in the
Planner floor plan and the database. Also temporarily modify
the expiry date for a planogram in the database. Manually
publish and verify that:

= The files publish to the specified directories with the correct
file names.

= If printing as a hard copy, the files are collated in the right
order.

»  Pre-processing has reconciled the differences between the
floor plan and database.

= Any expired planograms are flagged.

Planogram Reports

Manually print off some example planogram reports. Compare
to original planogram design.

Planogram Publishing

Copy some planograms and set the Publish Date to a date in the
recent past. Place in some temporary floor plans. Manually
publish and verify that:

s The planogram designs publish to the correct directories
with the correct file names.

= The planogram design is published using the specified
template.

s The planogram designs are collated as required.

Batch Processes

Batch processes are used to automate many of the processes in MSP used for retail
chain wide activities such as floor plan or planogram publishing. Some of these batch
processes have been tested manually at an earlier stage. As such they will only require
limited testing. Others, such as planogram substitution and update status, will not
have been tested before and may require more extended checks.

Table 14-8 Validation of Batch Processes

Action

Validation

Floor Plan Automated
Processing

Create several example floor plans in Planner. Modify some of
these floor plans in ISSC. Run Floor Plan Automated Processing
as a batch process with the /OUTOF SYNC flag. Verify that only
the modified floor plans have been processed.

Data Importer

Call an import via the scheduling tool. Verify the database is
updated as required and the changes are visible in the pertinent
dialog boxes. This can be done by taking a subset of data from
the retailer and importing that as a test.

Planogram Import

Run a delta planogram import (differences only). Identify the
differences before hand and verify the pertinent changes to
planogram hierarchy and planogram design are present.
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Configuring Reporting

Table 14-8 (Cont.) Validation of Batch Processes

Action

Validation

Adjacency Calculations

Create some temporary floor plans with gondolas, aisles and
planograms. Run adjacency calculations as a batch processes.
Entries should appear in the pertinent database tables - for
example AVTTB_FIXTURE_ADJACENCY.

Planogram Substitution

Create some temporary floor plans in Planner and place several
planograms in them. Manually set up some simple planogram
substitutions in the Administration module. Run planogram
substitutions as a batch process and verify the substitutions have
occurred.

Because the substitutions occur purely in the database, the
Planner floor plan will have to be synchronized ‘'match the
database’ before the changes are visible in the floor plan.

alternatively, if Auto Sync is enabled, opening the floor plan will
automatically add the changes.

Automated Calculations

Create some temporary floor plans with gondolas, aisles and
planograms. Run adjacency calculations as a batch processes.
Entries should appear in the pertinent database tables.

Floor Plan Publishing

The detail of floor plan publishing was checked in the section on
Planner module configuration. This validation test verifies that
floor plans will publish as part of a batch process.

Create some temporary floor plans and set the Publish Date
accordingly. Verify that they publish as a result of the batch
process.

Planogram Publishing

The detail of planogram publishing was checked in the section
on Planner module configuration. This validation test verifies
that planogram designs will publish as part of a batch process.

Create some temporary planograms by copying some existing
ones and set the Publish date to the past. Place examples in some
floor plans. Verify they publish as part of the batch process.

Update Status

Create some temporary stores. Set some to Proposed status with
the Opened Date in the past. Set some to Open status with the
Closed date in the past. Also create some floor plans with the
Effective Date set to a date in the past.

Run Update Status as part of a batch process and verify that the
store statuses change to Open or Closed as appropriate. Also
verify that the floor plan statuses change to Current as
appropriate.

Configuring Reporting

Reporting is used both the validate the placement of objects in a floor plan and to
report on the performance of that floor plan after it has gone into service.

Table 14-9 Validation of Configuring Reporting

Action

Validation

Custom Queries

If any Custom Queries have been modified, verify that the
pertinent dialog boxes are showing the required fields.
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ISSC Setup

ISSC Setup

Table 14-9 (Cont.) Validation of Configuring Reporting

Action

Validation

Quick Reports

Quick Reports can be tested in one of two ways:
= Using an example floor plan

= Entering a set of test data in the database and verifying the
Custom SQL for the Quick Report

Verify any existing Quick Reports function correctly. If any new
Quick Reports have been created, they should be subjected to
slightly more extensive testing.

KPIs

Test any existing KPIs on an example floor plan or enter a set of
test data into the database and verify the correct results are
returned. An example of the latter option would be entering or
importing POS data to verify a financial KPI.

If any new KPIs have been created, they should be subjected to
slightly more extensive testing

External Reports

Validate the external reports as required. An example would be
validating the reports that show the contents of tables in the
database used for logging. An example would be a report
showing the contents of the AVITB_PROCESS_FILE_LOG table
which holds information on which floor plans have been
modified by a batch process.

ISSC setup is configuring ISSC to modify the visual appearance and functionality for

users.

Table 14-10 Validation of ISSC Set Up

Action

Validation

Save Dialog Boxes

Log in as a user with the appropriate privileges and check that
the Submit, Accept and Reject buttons change the floor plan
status to the designated one.

As there are three different forms of the Save dialog box, this
will require testing with users from three different user groups.

District Manager Button

Log in as a user with the appropriate privileges and check that
the District Manager button brings all files of the required status.
Further verify that the Accept and Reject buttons change the
floor plan status to the designated on

General System Variables

Verify correct operation for any system variables that have been
changed from their default values.

Merchandising System
Variables

Verify correct operation for any system variables that have been
changed from their default values.

Annotation System
Variables

Verify correct appearance of zone annotation, fixture annotation,
profile annotation and product annotation.

Markup System Variables

Verify left and right mouse buttons draw lines of the correct
weight.

Note System Variables

Verify correct appearance.

Duplicating Floor Plans

Verify that a duplicated floor plan has the intended status.
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Follow Up Actions

ISSC Mobile Setup

The ISSC Mobile set up is designed to configure access to the application and allow
modification of KPIs and Custom Queries to be carried. The Notes functionality is also

verified.

Table 14-11 Validation of ISSC Mobile Set Up

Action

Validation

Users and User Groups

Verify a specific user can log into the designated store.

Fixture KPI

Copy a Current floor plan in Planner. Make the later copy
Current, and change some fixture positions in it. Modify the
database dates as required so the effective dates of the floor
plans are less than 7 days apart. Open the more recent floor plan
in ISSC mobile and verify the changes to the fixtures show in the
KPL

Merchandise KPI

Copy a Current floor plan in Planner. Make the later copy
Current, and change some planograms in it. Modify the
database dates as required so the effective dates of the floor
plans are less than 7 days apart. Open the more recent floor plan
in ISSC mobile and verify the changes to the merchandise show
in the KPI.

Notes

Create notes and verify they are visible in MSM (Store Manager)
and ISSC (from toolbar).

Custom Queries
(If modified)

If modified, verify the queries return the required results.

Follow Up Actions

Follow up actions are out of the scope of this implementation guide. As such no
validation actions are specified.
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A

Information Locations

This section of the implementation guide contains information on where detailed
information on configuring functionality can be found. Each section corresponds to a
chapter in the implementation guide.

= General Information

s Initial Security

= Basic Data Configuration
= Data Import

= Initial Fixture Studio Setup
s Initial Planner Setup

= Planner Configuration

= Batch Processes

s ISSC Set Up

= ISSC Mobile Set Up

= Configuring Reporting

»  Follow Up Actions

General Information

The Oracle Retail Macro Space Management Data Model contains information on bitwise
and enumerated values used for system variables. Its entity relationship diagrams
show the relationship between tables in the database. This and other information
contained in the data model is essential for SIs configuring the application.

Initial Security

Initial on configuring initial security and setting up initial users can be found in the
following locations.

Table A-1 Initial Security Information

Security Action Location of Information

Setting Security Options Section on Security Options in the Administration Module User
Guide.

Adding other Section on Functional Security in the Administration Module

Administrative Users User Guide.
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Basic Data Configuration

Table A-1 (Cont.) Initial Security Information

Security Action Location of Information

Associating User Groups Section on Functional Security in the Administration Module

with Functionality User Guide.

Adding other users Section on Functional Security in the Administration Module
User Guide.

Basic Data Configuration

Information on basic data configuration can be found in the following locations:

Table A-2 Basic Data Configuration Option

Configuration Action Location of Information

Configuration Module Information on the Options Tab and Directories tab in the
Configuration Module User Guide.

Calendar Data Section on Calendars in the Administration Module User Guide.

Statuses Section on Calendars in the Administration Module User Guide.

Zone Definitions Section on Zones in the Administration Module User Guide.
Information on placing zones in the Planner Module User
Guide.

Data Import

Information on the import of the store hierarchy together with product and planogram
information can be found in the following locations.

Table A-3 General Data Import Information

Data Import process Location of Information
Data Importer Data Importer User Guide.
Planogram Import This is in two sections: creating the XML file and

importing the data.

= Information on creating the XML file is in a white
paper called Planogram Import on My Oracle
Support.

= Information on importing the planogram information
is in the following document on OTN: ODI Planogram
Import, User Guide, Volume 1.

Table A-4 Detailed Data Import Information

Data Import Action Location of Information

Planogram Import Styles Section on Planogram import styles in the Merchandising
section of the Administration Module User Guide.

System Variables for Planogram  Some of the system variables are described in the General
Import section of the Administration Module User Guide.

Importing Store Hierarchy via See the Data Importer User Guide for general information.
Data Importer

Importing Product Hierarchy via ~ See the Data Importer User Guide for general information.
Data Importer

Planogram Import via ODI See the ODI Planogram Import, User Guide, Volume 1.
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Planner Configuration

Initial Fixture Studio Setup

Information on the initial set-up tasks in Planner can be found in the following
locations in the Oracle Retail Macro Space Management Fixture Studio User Guide.

Table A-5 Initial Fixture Studio Set Up Information

Fixture Studio Action

Location

Remapping System Blocks

Categories tab in the Block Details dialog box section.

Create Fixture Hierarchy

Fixture Groups in Fixture Creation section.

Creating Fixtures

Sections on Fixture Creation and Block Details dialog box.

Create Gondola Hierarchy

Gondola Hierarchies section.

Creating Gondolas

Worked examples in Gondolas section.

Initial Planner Setup

Information on the initial set-up tasks in Planner can be found in the following

locations.

Table A-6 Initial Planner Setup Information

Setup Action

Location of Information

Store Manager System

Information on system variables in System Variable section of

Variables Administration Module User Guide.

Synchronisation Information on system variables in System Variable section of
Administration Module User Guide. Information on manual
synchronization in Planner Module User Guide.

Configuring Layers Not presently covered in User Guides.

Selecting Cluster and Store

Store Manager section of Planner Module User Guide.

Associating an Architectural
Plan

See the Using Architectural Plans section of the Planner Module
User Guide.

Laying out Zones

Zones section of the Planner Module User Guide.

Fixturing

Equipment section in the Planner Module User Guide.

Aisles

Aisles section in the Planner Module User Guide.

Products and Planograms

Merchandise section in the Planner Module User Guide.

Creating a temporary floor
plan

Information in varying parts of the Planner User Guide.

Planner Configuration

Information on the section on Planner configuration can be found in the following

locations:

Table A-7 Planner Configuration Information

Planner Action

Location of Information

Text Styles

Section on configuring Text Styles in Administration module
user Guide. Section on Using Annotation in Planner Module
User Guide.
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Batch Processes

Table A-7 (Cont.) Planner Configuration Information

Planner Action Location of Information

Title Blocks Section on how to register blocks in Fixture Studio User guide.
Section on creating the DWG Title Block and how to use it in the
Planner Module User Guide. Section on how to configure them
for Planner use in the Administration Module User Guide.

Floor Plan Publishing Administration Module User Guide. Additional information in
Planner Module User Guide.

Planogram Reports Report Designer User Guide.

Planogram Publishing Administration Module User Guide. Additional information in

Planner Module User Guide.

Batch Processes

Information in the section on batch processes can be found in the following locations:

Table A-8 Batch Process Information

Batch Process

Location of Information

Floor Plan Automated Processing

Administration Module User Guide. Additional
information in Planner Module User Guide.

Data Importer

Data Importer User Guide

Planogram Import

This is in two sections: creating the XML file and
importing the data.

= Information on creating the XML file is in a white
paper called Planogram Import on My Oracle
Support.

= Information on importing the planogram information
is in the following document on OTN: ODI Planogram
Import, User Guide, Volume 1.

Adjacency Calculations

Section on Calculations in Planner module contains
information on how Adjacency Calculations work.

Planogram Substitution

Administration Module User Guide. See the section on
Functional Security as to how to configure access to the
planogram substitution functionality. There is an second
section on the planogram substitution functionality itself.

Automated Calculations

Section on Calculations in Planner module contains
information on how Calculations work.

Floor Plan Publishing Administration Module User Guide. Additional
information in Planner Module User Guide.

Planogram Publishing Administration Module User Guide. Additional
information in Planner Module User Guide.

Update Status Section on Update Status in Planner Module User Guide.

ISSC Set Up

Information in the section on ISSC Set Up can be found in the following locations:

Table A-9 ISSC Set Up Information

ISSC Set Up Action Information

Users and User Groups Security section in Administration Module User Guide.
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Follow Up Actions

Table A-9 (Cont.) ISSC Set Up Information

ISSC Set Up Action Information

Statuses and Status Levels  Pertinent sections in Administration Module User Guide.
Save Dialog Boxes In-Store Space Collaboration User Guide.

District Manager Button In-Store Space Collaboration User Guide.

System Variable Pertinent sections in Administration Module User Guide.

ISSC Mobile Set Up

General information on ISSC Mobile can be found in the Oracle Retail Macro Space
Planning ISSC Mobile User Guide. Information on configuring it can be found in the
following locations.

Table A-10 ISSC Mobile configuration Information

ISSC Mobile Action Location of Information

Configuring Users and User Section on Security in the Administration Module User Guide.
Groups

configuring Functional and  Section on Security in the Administration Module User Guide.
Data Security

Configuring Custom Section on Custom Queries in the Administration Module User
Queries Guide.

Configuring Reporting

Information on configuring reporting can be found in the following locations:

Table A-11 Reporting Configuration Information

Report Option Location of Information

Customer Queries Section on Custom Queries in the Administration Module User
Guide.

Quick Reports Some information in the section on Quick Reports in the Planner
Module User Guide.

KPIs Section on KPIs in the General Menu section of the

Administration Module User Guide.

External Reporting Tool See pertinent documentation for that action.

Follow Up Actions

Some follow up actions are outside the scope of this implementation guide.
Information on some of the MSP functionality discussed can be found in the following
locations:

Table A-12  Follow Up Action Information

Follow Up Action Location of Information

User Defined Attributes Section on UDAs in Administration Module User Guide.
Adjacency Rules and Adjacency Rules and Severity Types sections in the
Severity Types Administration Module User Guide.
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Follow Up Actions

Table A-12 (Cont.) Follow Up Action Information

Follow Up Action Location of Information

Floor Plan Validation Pertinent sections of ISSC User Guide. For example the section
on Scanning Planograms in the Merchandising section shows
how the identify of planograms physically in a store can be

verified.
General Database See the Oracle Retail Macro Space Management Data Model for
Maintenance Actions information on the specified tables.
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Glossary

2D/3D Fixtures

Specialized way of configuring AutoCAD blocks so they can be toggled between 2D
and 3D form in a Planner floor plan.

2D/3D Planograms

Planograms can be placed in one of three forms in the Merchandise module.

= 2D form: header information only.

= 25D form: planogram has shelves and products blocks to represent position of
products. No information on number or orientation of products.

= 3D form: full information on shelves or products.

Planograms can only be placed in 2D form in Planner. They can only be seen in 3D
form is ISSC and ISSC Mobile if first set to that form in Merchandiser.

3DS File

These are 3D Studio graphics files. 3DS files can be created from AutoCAD drawing
files. They are used to represent objects in the Merchandiser module. They are also
used in the Preview tab of the Block Details dialog box in Fixture Studio.

BatchRunner

Batchrunner.exe is a small tool used to invoke the batch processes used for Planogram
Substitution, Floor Plan Automated Processing, Floor Plan Publishing and Planogram
Publishing.

Bitwise Variable

Bitwise variables are typically used to specify combinations of options. Consider the
following list:

1= Option A
2 = Option B
4 = Option C
8 = Option D

The numbering sequence for a bitwise variable is such that every combination sums to
a unique value. Thus options A, B and D would result in a bitwise variable value of 11.

Block

Blocks are named groups of AutoCAD objects that act as a single 2D or 3D object.
Blocks are used in the Planner module to represent objects in the floor plan such as
fixtures, fittings or merchandise. The term block is also sometimes used as a generic
term in MSM to describe these objects.
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Canonical Media

Glossary-2

Canonical Media

List of sizes for printing hard copy or electronic versions of floor plans. Read by
AutoCAD from the available printers and plotters and imported into the database.

Cluster

User as a container in the store hierarchy for stores sharing a common characteristic.
Examples of such characteristics are location or store size.

Command Group

Used in the functional Security dialog box in the Administration module. Controls
access to functionality.

Custom SQL
An extension of standard SQL. Valid only in specific parts of the MSP suite.

Data Security

This option (accessed from the Security Menu in the Administration Module)
determines what objects users can access. This affects which stores, statuses, products
or planograms can be read, edited or deleted.

Display Style

Used within MSMs Merchandiser module and in ISSC to describe the physical form
and dimensions of a SKU (Product Item).

DWG File

AutoCAD file used in the Planner module. It can contain varying levels of detail
ranging from a full floor plan down to an individual fixture.

ETL Tool

Extract, Transform and Load tools are software designed to take data from one
database, modify the form if required and insert it into another database.

Fitting
An item of equipment that cannot accept merchandise. Fittings can be placed directly

on the floor or onto fixtures or shelves. An example of a fitting would be the gates that
scan for security tags when shoppers leave the store.

Fixel

An alternative name for an item of equipment in the planogram design.

Fixture

An item of equipment that can accept merchandise, either directly, or on shelves.
Fixtures are typically placed on the floor. An example of a fixtures would be a chiller
unit.

Fixture Hierarchy

The Fixture Hierarchy is an arrangement of fixture groups and associated fixtures that
allow manual navigation to specific fixtures during floor planning. It is created in the
Fixture Studio module and displays in the Object Browser in the Planner and
Merchandiser modules and in In-Store Space Collaboration.



System Integrator (SI)

Functional Security

This option (accessed from the Security Menu in the Administration Module)
determines what functionality users can access

Gondola

Pre-configured arrangement of fixtures set up in Fixture Studio. This allows long runs
of fixtures to be rapidly placed - and hence to represent real life gondolas in stores.
ISSC (In-Store Space Collaboration)

Internet Enabled store planning application that can be deployed to stores. Dependent
on MSM.

ISSC Mobile

A partner application of ISSC designed for use on a mobile device. It can be used by
store associates to see changes in fixturing and merchandise in a specific store and to
collaborate with other retail employees. Dependent on ISSC.

Key Performance Indicator (KPI)

A way of showing performance by color coding objects in a floor plan or planogram.

MSM (Macro Space Management)

Store Planning suite intended for use at corporate headquarters.

MSP (Macro Space Planning)

Umbrella term for the software suite comprising Macro Space Management (MSM)
and In-Store Space Collaboration (ISSC).

Object Browser

Control in the Planner and Merchandiser modules in MSM and in ISSC used to initiate
actions involving zones, equipment, merchandise and KPIs.

Object Grid

Control in the Planner and Merchandiser modules in MSM. Provides an alternative
way to place equipment and merchandise.

Oracle Data Integrator (ODI)

Oracle’s ETL tool. It can be supplies with pre configured scenarios to import
planogram designs from an XML file of specified form.

Quick Report

A customizable dialog box within MSM and ISSC. The information can be configured
to suit retailer requirements.

Status

Used to indicate where an object is in its business life cycle. Certain actions can only be
carried out when an object is at a specific status.

System Integrator (SI)

In the context of this document, used as a generic term to describe a person with the
appropriate skills to carry out implementation tasks.
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Template Database

Glossary-4

Template Database

Database created from a supplied script. The database is populated with sufficient
information for MSP to open and for the functionality to be accessible. The SIs task is
to add the information required for a retailer to begin store planning.

UpdateStatus
updateStatus.exe is a small executable file used to change the status of floor plans and
stores.

User Defined Attribute

Customizable information that can be assigned to fixtures, files, planograms,
planogram equipment (fixels), planogram products, planogram profiles (bays),
products, stores and users.

Zone

Used within MSP to indicate an area of floor used for a specific purpose. The Internal
Area zone is used to delineate the total area used for retail purposes. The Food and
Drink zone might indicate the floor area associated with the Food & Drink
department.
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